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Preface

Thank you for purchasing the TOSHIBA multifunctional digital system e-STUDIO165/205, 
e-STUDIO167/207/237, or e-STUDIO182/212/242. 
This is a supplemental manual that describes the GA-1191 support for Windows 7 and Mac OS, 
and the GA-1201 support for Windows 7.

Please refer to “GA-1191 Printing Guide” and “GA-1201 Scanning Guide” along with this man-
ual.
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Software License Agreement

INSTALLING OR OTHERWISE USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR 
ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS (UNLESS A SEPARATE 
LICENSE IS PROVIDED BY THE SUPPLIER OF APPLICABLE SOFTWARE IN WHICH CASE 
SUCH SEPARATE LICENSE SHALL APPLY). IF YOU DO NOT ACCEPT THESE TERMS, YOU 
MAY NOT INSTALL OR USE THIS SOFTWARE, AND YOU MUST PROMPTLY RETURN THE 
SOFTWARE TO THE LOCATION WHERE YOU OBTAINED IT.

THE SOFTWARE INSTALLED ON THIS PRODUCT INCLUDES NUMEROUS INDIVIDUAL 
SOFTWARE COMPONENTS, EACH HAVING ITS OWN APPLICABLE END USER LICENSE 
AGREEMENT (“EULA”). INFORMATION RELATING TO THE EULAS MAY BE FOUND IN AN 
ELECTRONIC FILE INCLUDED ON THE USER DOCUMENTATION CD-ROM INCLUDED 
HEREWITH; HOWEVER, ALL SOFTWARE AND DOCUMENTATION DEVELOPED OR CRE-
ATED BY OR FOR TOSHIBA TEC CORPORATION (“TTEC”) ARE PROPRIETARY PROD-
UCTS OF TTEC AND ARE PROTECTED BY COPYRIGHT LAWS, INTERNATIONAL TREATY 
PROVISIONS, AND OTHER APPLICABLE LAWS.

Grant of License
This is a legal agreement between you, the end-user (“You”), and TTEC and its suppliers. This 
software, fonts (including their typefaces) and related documentation (“Software”) is licensed for 
use with the system CPU on which it was installed (“System”) in accordance with the terms con-
tained in this Agreement. This Software is proprietary to TTEC and/or its suppliers.

TTEC and its suppliers disclaim responsibility for the installation and/or use of this Software, and 
for the results obtained by using this Software. You may use one copy of the Software as 
installed on a single System, and may not copy the Software for any reason except as neces-
sary to use the Software on a single System. Any copies of the Software shall be subject to the 
conditions of this Agreement.

You may not, nor cause or permit any third party to, modify, adapt, merge, translate, reverse 
compile, reverse assemble, or reverse engineer the Software. You may not use the Software, 
except in accordance with this license. No title to the intellectual property in the Software is 
transferred to you and full ownership is retained by TTEC or its suppliers. Source code of the 
Software is not licensed to you. You will be held legally responsible for any copyright infringe-
ment, unauthorized transfer, reproduction or use of the Software or its documentation.

Term
This license is effective until terminated by TTEC or upon your failure to comply with any term of 
this Agreement. Upon termination, you agree to destroy all copies of the Software and its docu-
mentation.

You may terminate this license at any time by destroying the Software and its documentation 
and all copies.
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Disclaimer of Warranty
THIS SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-
INFRINGEMENT. TTEC AND ITS SUPPLIERS DISCLAIM ANY WARRANTY RELATING TO 
THE QUALITY AND PERFORMANCE OF THE SOFTWARE. IF THE SOFTWARE PROVES 
DEFECTIVE, YOU (AND NOT TTEC OR ITS SUPPLIERS) SHALL BE RESPONSIBLE FOR 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. TTEC 
AND ITS SUPPLIERS DO NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE.

ALL INFORMATION CONTAINED HEREIN THAT IS PROVIDED BY TTEC AND ITS AFFILI-
ATES PURSUANT TO A EULA IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED.

Limitation of Liability
IN NO EVENT WILL TTEC OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES, 
WHETHER IN CONTRACT, TORT, OR OTHERWISE (EXCEPT PERSONAL INJURY OR 
DEATH RESULTING FROM NEGLIGENCE ON THE PART OF TTEC OR ITS SUPPLIERS), 
INCLUDING WITHOUT LIMITATION ANY LOST PROFITS, LOST DATA, LOST SAVINGS OR 
OTHER INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OR INABILITY TO USE THE SOFTWARE, EVEN IF TTEC OR ITS SUPPLIERS HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, NOR FOR THIRD PARTY 
CLAIMS.

U.S. Government Restricted Rights
The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the 
U.S. Government is subject to restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the 
Rights in Technical Data and Computer Software Clause set forth in 252.227-7013, or 52.227-19 
(c) (2) of the DOD FAR, as appropriate. Contractor/Manufacturer is TOSHIBA TEC Corporation, 
2-17-2, Higashigotanda, Shinagawa-ku, Tokyo, 141-8664, Japan.

General
You may not sublicense, lease, rent, assign or transfer this license or the Software. Any attempt 
to sublicense, lease, rent, assign or transfer any of the rights, duties or obligations hereunder is 
void. You agree that you do not intend to, and will not ship, transmit (directly or indirectly) the 
Software, including any copies of the Software, or any technical data contained in the Software 
or its media, or any direct product thereof, to any country or destination prohibited by the United 
States Government. This license shall be governed by the laws of Japan or, at the election of a 
Supplier of TTEC concerned with a dispute arising from or relating to this Agreement, the laws of 
the Country designated from time to time by the relevant Supplier of TTEC. If any provision or 
portion of this Agreement shall be found to be illegal, invalid or unenforceable, the remaining 
provisions or portions shall remain in full force and effect.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT 
YOU UNDERSTAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU FURTHER AGREE THAT THIS LICENSE AGREEMENT CONTAINS THE 
COMPLETE AND EXCLUSIVE AGREEMENT BETWEEN YOU AND TTEC AND ITS SUPPLI-
ERS AND SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, 
OR ANY OTHER COMMUNICATION RELATING TO THE SUBJECT MATTER OF THIS 
LICENSE AGREEMENT.

TOSHIBA TEC Corporation, 2-17-2, Higashigotanda, Shinagawa-ku, Tokyo, 141-8664, Japan.
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How to Read This Manual

Symbols in this manual 
In this manual, some important items are descried with the symbols shown below. Be sure to 
read these items before using this equipment.

Trademarks
The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
The official name of Windows XP is Microsoft Windows XP Operating System.
The official name of Windows Vista is Microsoft Windows Vista Operating System.
The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating 
System.
The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating 
System.
The official name of Windows 7 is Microsoft Windows 7 Operating System.
Microsoft, Windows, Windows NT, and the brand names and product names of other 
Microsoft products are trademarks of Microsoft Corporation in the US and other countries.
Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple 
Inc. in the US and other countries.
Adobe, Adobe Acrobat, Adobe Reader, Adobe Acrobat Reader, and PostScript are trade-
marks of Adobe Systems Incorporated.
Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Founda-
tion in the U.S. and other countries.
Netscape is a trademark of Netscape Communications Corporation.
IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
TopAccess is a trademark of Toshiba Tec Corporation.
Other company names and product names in this manual are the trademarks of their respec-
tive companies.

©2010 TOSHIBA TEC CORPORATION All rights reserved
This manual is protected by copyright laws. No part of this manual shall be duplicated or repro-
duced without the permission of TOSHIBA TEC CORPORATION. TOSHIBA TEC CORPORA-
TION shall not be liable in terms of granting patents for any use of information contained in this 
manual by third parties.

Indicates information to which you should pay attention when operating the 
equipment.

Describes handy information that is useful to know when operating the equip-
ment.

Pages describing items related to what you are currently doing. See these 
pages as required. 
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About the Client Utilities CD-ROM (GA-1191)

For Windows
The contents of the Client Utilities CD-ROM for printing:

Client software installer
[Client Utilities CD-ROM]:\Client\setup.exe
This is the setup program to install the printer drivers on your computer.

PCL6 printer drivers
[Client Utilities CD-ROM]:\W2K_XP_VISTA\PCL6\<language>\
This includes the setup files to install the PCL6 printer driver on the Windows 2000/
Windows XP/Windows Vista/Windows 7/Windows Server 2003/Windows Server 2008 for 
each language version by Add Printer Wizard or Plug and Play.
[Client Utilities CD-ROM]:\XP_VISTA_X64\PCL6\<language>\
This includes the setup files to install the PCL6 printer driver on the Windows XP/
Windows Vista/Windows 7/Windows Server 2003/Windows Server 2008 64-bit edition for 
each language version by Add Printer Wizard or Plug and Play.

PS3 printer drivers (PostScript)
[Client Utilities CD-ROM]:\W2K_XP_VISTA\PS\<language>\
This includes the setup files to install the PS3 printer driver on the Windows 2000/
Windows XP/Windows Vista/Windows 7/Windows Server 2003/Windows Server 2008 for 
each language version by Add Printer Wizard or Plug and Play.
[Client Utilities CD-ROM]:\XP_VISTA_X64\PS\<language>\
This includes the setup files to install the PS3 printer driver on the Windows XP/
Windows Vista/Windows 7/Windows Server 2003/Windows Server 2008 64-bit edition for 
each language version by Add Printer Wizard or Plug and Play.

When you want to perform printing from Windows 98/Windows Me/Windows NT using 
e-STUDIO165/205 or e-STUDIO167/207/237, contact your service technician or representative.

Further information about printer driver for Windows is described in the following operator's 
manual.

 P.12 “About client software for Windows”

N/W-Fax driver

AddressBook Viewer
Please refer to the following manual for details about N/W-Fax driver and AddressBook 
Viewer.

 “GA-1191 Network Fax Guide”
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For Macintosh
The contents of the Client Utilities CD-ROM for printing:

Macintosh PPD files
[Client Utilities CD-ROM]:MacPPD:OSX:10_2-10_3
This includes the PPD file to enable printing from Macintosh on the Mac OS X 10.2.4 to 
Mac OS X 10.3.x.
[Client Utilities CD-ROM]:MacPPD:OSX:10_4-
This includes the PPD file to enable printing from Macintosh on the Mac OS X 10.4.x to 
Mac OS X 10.6.x.

When you want to perform printing from Mac OS 8.6/9.x or Mac OS X 10.1/10.2 Classic 
Mode using e-STUDIO165/205 or e-STUDIO167/207/237, contact your service technician or 
representative.
Please make sure to follow the procedure described in this manual when you install the Mac-
intosh PPD files. For the Mac OS X 10.6.x support, the folder structure of the Client Utilitites 
CD-ROM is changed from the one described in “GA-1191 Printing Guide”.

Further information about PPD (PostScript Printer Description) for Macintosh is described in 
next chapter.

 P.55 “About client software for Macintosh”

For UNIX
The contents of the Client Utilities CD-ROM for printing:

CUPS PPD files
[Client Utilities CD-ROM]/Admin/CUPS/ENG/
This includes the CUPS PPD files for UNIX.

Further information about CUPS for UNIX is described in the following operator's manual.
 “GA-1191 Printing Guide” - “About CUPS”
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About the Scan Utilities CD-ROM (GA-1201)

The contents of the Scan Utilities CD-ROM are as follows:

Client software installer
[Scan Utilities CD-ROM]: \setup.exe
The above is a setup program to install TWAIN driver on your computer.

TWAIN driver
[Scan Utilities CD-ROM]: \TWAIN\<language>
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Installing Client Software for Windows

About client software for Windows

Printer drivers
Printer drivers are software components that enable application programs to interact with the 
printer. The e-STUDIO165/205, e-STUDIO167/207/237, or e-STUDIO182/212/242 comes with 
two printer drivers, PCL6 and PS3 (PostScript) printer drivers. These printer drivers offer docu-
ment print, layout and assembly functions that are not available with many applications.

Planning for installation
This section will help you to plan an installation suited to your environment. Before installing the 
client software, read this section.

Before installing client software
Before installing the client software, confirm the followings to perform an appropriate installation.

— When same printer drivers have been installed
If the printer driver of the e-STUDIO165/205, e-STUDIO167/207/237, or e-STUDIO182/212/242 
is already installed, be sure to uninstall it regardless of its software version before starting the 
installation with the attached Client Utilities CD-ROM.

 P.48 “Uninstalling client utilities software”

Type of printer drivers
PCL6 printer driver — This printer driver is suitable for printing from a general application, 
such as word processing or calculation.
PS3 printer driver — This printer driver is suitable for printing from a general application, 
such as word processing or calculation, and a DTP application supporting PostScript.
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System requirements
To install the printer drivers and other client software on a Windows computer, the following is 
required.

Display resolution
1024 x 768 dots or more
Display color
16bits (high color) or more
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
Memory
The required memory size for OS.
OS
Windows 2000 Service Pack 4
Windows XP Service Pack 2 or later
Windows Vista Service Pack 1 or later
Windows 7
Windows Server 2003 Service Pack 2
Windows Server 2008 Service Pack 1 or later

Further information about printer driver for Windows 2000, Windows XP, Windows Vista, Win-
dows Server 2003, and Windows Server 2008 is described in the following operator's manual.

 “GA-1191 Printing Guide” - “About client software for windows”
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About installation procedure for Windows 7
Please find the installation procedure suited to your environment from the following:

 P.14 “USB connection”
 P.14 “Local area network over TCP/IP”
 P.15 “IPP printing”

— USB connection

This equipment supports the USB 2.0 Full Speed connection. You must install the printer drivers 
with this equipment connected to your computer using the USB cable.

 P.17 “Installing client software for USB printing”

— Local area network over TCP/IP
When this equipment is connected to your computer in the local area network over TCP/IP, Raw 
TCP/LPR printing is available.

If you have no advance for an installation from your administrator, check these printing methods 
whether they are suited to your network environments.

Raw TCP/LPR printing

This equipment can be used with Raw TCP printing connection (recommended) or LPR printing 
connection.

 P.23 “Installing client software for Raw TCP/LPR printing”

To print with a Raw TCP connection, this equipment must be configured to enable Raw TCP 
Print Service. Ask your administrator if the Raw TCP Print Service is enabled.
To print with a LPR connection, this equipment must be configured to enable LPD Print Ser-
vice. Ask your administrator if the LPD Print Service is enabled.

Connecting with USB

Setting up the USB Printer

Connection 

Windows 2000

Windows XP

Windows Server 2003

Windows Vista

Windows Server 2008

Windows 7

Connecting over TCP/IP Network

Setting up the Raw TCP

or LPR printer connection

Windows 2000
Windows XP
Windows Server 2003
Windows Vista
Windows Server 2008
Windows 7
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— IPP printing

This equipment can be used with IPP printing. This allows you to print to this equipment from 
anywhere on the Internet.

 P.41 “Installing client software for IPP printing”

To print with an IPP connection, this equipment must be configured to enable the IPP Print Ser-
vice and must be connected to the Internet. Ask your administrator if the IPP Print Service is 
enabled.

Connecting over Internet

Setting up the IPP

printer connection

Windows 2000
Windows XP
Windows Server 2003
Windows Vista
Windows Server 2008
Windows 7
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Installation procedure list for Windows client software
The following table shows the procedure list to install printer drivers.

*1 By selecting the discovered equipment, the printer port is automatically set.

Printing OS Means to install
USB printing Windows 2000

 “GA 1191 Printing Guide” - “Installing client software 
for USB printing - Installation for USB printing by Plug and 
Play — Windows 2000”

Plug and Play

Windows XP/Server 2003/Vista/Server 2008
 “GA 1191 Printing Guide” - “Installing client software 

for USB printing - Installation for USB printing by Plug and 
Play — Windows XP/Server 2003/Vista/Server 2008”
Windows 7

 P.17 “Installation for USB printing by connecting the 
equipment”

Installer

Raw TCP/LPR 
printing

Windows 2000/XP/Server 2003/Vista/Server 2008
 “GA 1191 Printing Guide” - “Installing client software 

for Raw TCP/LPR printing - Installation for Raw TCP/LPR 
printing using the installer”

Installer*1

Windows 7
 P.23 “Installation for Raw TCP/LPR printing using the 

installer”
Windows 2000/XP/Server 2003/Vista/Server 2008

 “GA 1191 Printing Guide” - “Installing client software 
for Raw TCP/LPR printing - Installation for Raw TCP/LPR 
Printing by Add Printer Wizard”

Add Printer Wizard

Windows 7
 P.33 “Installation for Raw TCP/LPR Printing by Add 

Printer Wizard”
IPP printing Windows 2000/XP/Server 2003

 “GA 1191 Printing Guide” - “Installing client software 
for IPP printing - Installation for IPP printing by Add Printer 
Wizard — Windows 2000/XP/Server 2003”

Add Printer Wizard

Windows Vista/Server 2008
 “GA 1191 Printing Guide” - “Installing client software 

for IPP printing - Installation for IPP printing by Add Printer 
Wizard — Windows Vista/Server 2008”
Windows 7

 P.41 “Installation for IPP printing by Add Printer Wiz-
ard”

Uninstalling When installed using the installer
 P.48 “When installed using the installer”

When installed using Add Printer Wizard
 P.53 “When installed using Add Printer Wizard”
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Installing client software for USB printing
This section describes how to set up the printer drivers when this equipment is connected with 
USB cable.

TopAccess is not available when this equipment is connected using only the USB cable.

Installation for USB printing by connecting the equipment

Installing the printer driver for USB printing

Before proceeding to this section, you must logon Windows with a user account that allows you 
to install or uninstall client software (e.g. administrator privilege). If you are using Windows 7, 
you can temporarily change your user account to the one noted above with its User Account 
Control function. Ask your administrator for the details.

1 Power on this equipment and your computer.

2 Connect the USB cable to this equipment and your computer.

When the Driver Software Installation dialog box appears, click [Close].

3 Insert the Client Utilities CD-ROM into the CD-ROM drive.
The installer automatically starts and the Choose Setup Language dialog box 
appears.
When the installer does not automatically start, double-click “Setup.exe” in the Client 
Utilities CD-ROM.

4 Select your language and click [OK].

The Welcome to the InstallShield wizard screen is displayed.
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5 Click [Next].

The License Agreement screen is displayed.

6 Please read the license agreement carefully and click [Yes].

The Choose Destination Location screen is displayed.

7 Click [Next].

If you want to change where the programs are installed, click [Browse]. In the dialog box 
that appears, select the folder and click [OK].

The Setup Type screen is displayed.
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8 Select “Custom” and click [Next].

The Select Features screen is displayed.

9 Check the software that you want to install and click [Next].

TOSHIBA e-STUDIO205 Series PCL6 — Check this to install the PCL6 printer driver.
TOSHIBA e-STUDIO205 Series PSL3 — Check this to install the PS3 printer driver

The Select Port screen is displayed.

The names of other software are displayed in the Select Features dialog box. (You can 
install them as required.)

10 Since the result message of the detection is displayed, click [Con-
tinue].
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11 Select “USBxxx” (xxx are numbers) in the “Local Port” drop down 
box, and click [Next].

12 Click [Next].

If you want to change the program folder, rename the folder in the “Program Folder” field. 

The Start Copying Files screen is displayed. 
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13 Click [Next].

Starts copying files and the InstallShield Wizard Complete screen appears when this is 
completed.

If the Digital Signature Not Found dialog box is displayed while files are being copied, 
click [Yes] to continue the installation.
If the following message appears, click [Yes] to set the indicated printer driver to be 
the default printer driver, or click [No] to not change the default printer driver.
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14 Click [Finish].

The installation is completed.
The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart 
my computer now.” and click [Finish] to restart your computer.

Before using the printer driver for printing, please configure the installed options of the 
equipment and department code (if required) on the printer driver.

 P.88 “Before using the printer driver”

When a printer driver (e.g. PCL6) is installed by means of the above procedure, the 
“USB001 Virtual print port” is created. If you want to install a second driver (e.g. PS3), 
use “Add Printer Wizard” and add the printer driver in the Client Utility CD-ROM to this 
port. (To start the wizard: Click [Start] and select [Devices and Printers], and then click 
[Add a printer].)
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Installing client software for Raw TCP/LPR printing
This section describes how to set up the printer drivers for Raw TCP/LPR printing which is avail-
able for the local area network over TCP/IP.

There are Two ways to set up the printer drivers for Raw TCP/LPR printing:
Using the installer in the Client Utilities CD-ROM
You can set up the printer drivers for Raw TCP/LPR printing by installing the printer drivers 
using the installer in the Client Utilities CD-ROM.

 P.23 “Installation for Raw TCP/LPR printing using the installer”
Using Add Printer Wizard
When you want to install the printer drivers without using the installer, or when you want to 
install the same printer driver for another equipment, install the printer drivers using the Add 
Printer Wizard.

 P.33 “Installation for Raw TCP/LPR Printing by Add Printer Wizard”

Before operating the following setup, check with your system administrator to make sure of the 
following:

This equipment is connected to the network and turned on.
The TCP/IP setting is correct on this equipment and your computer.

Installation for Raw TCP/LPR printing using the installer
Install the client software using the installer in the Client Utilities CD-ROM.

Before proceeding to this section, you must logon Windows with a user account that allows you 
to install or uninstall client software (e.g. administrator privilege). If you are using Windows 7, 
you can temporarily change your user account to the one noted above with its User Account 
Control function. Ask your administrator for the details.

Installing the client software for Raw TCP/LPR printing using the installer

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
The installer automatically starts and the Choose Setup Language dialog box 
appears.
When the installer does not automatically start, double-click “Setup.exe” in the Client 
Utilities CD-ROM.

2 Select your language and click [OK].

The Welcome to the InstallShield wizard screen is displayed.
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3 Click [Next].

The License Agreement screen is displayed.

4 Please read the license agreement carefully and click [Yes].

The Choose Destination Location screen is displayed.

5 Click [Next].

If you want to change where the programs are installed, click [Browse]. In the dialog box 
that appears, select the folder and click [OK].

The Setup Type screen is displayed.
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6 Select “Custom” and click [Next].

The Select Features screen is displayed.

7 Check the software that you want to install and click [Next].

TOSHIBA e-STUDIO205 Series PCL6 — Check this to install the PCL6 printer driver.
TOSHIBA e-STUDIO205 Series PSL3 — Check this to install the PS3 printer driver

The Select Port screen is displayed.

The names of other software are displayed in the Select Features dialog box. (You can 
install them as required.)
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8 Since the installer detects this equipment and the name of this 
equipment is displayed at “Devices on Network”, select it and then 
click [Next].

The Select Program Folder screen is displayed.

If this equipment is not properly connected in your network, the message that the installer 
cannot discover this equipment is displayed.
Click [Retry] to search again. Click [Continue] to configure a local port.

Select “Local Port” to configure a local port, and then select in the drop down box the 
desired port configured previously. If a local port is not configured previously, select any 
port in the drop down box as a temporary port so that you can continue the installation. 
Then click [Next].

If you selected a temporary port in the step above, you need to configure a correct port 
after installation. See “Note” in step 11.
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9 Click [Next].

If you want to change the program folder, rename the folder in the “Program Folder” field. 

The Start Copying Files screen is displayed. 

10 Click [Next].

Starts copying files and the InstallShield Wizard Complete screen appears when this is 
completed.

If the Digital Signature Not Found dialog box is displayed while files are being copied. 
Click [Yes] to continue the installation.
If the following message appears, click [Yes] to set the indicated printer driver to be 
the default printer driver, or click [No] to not change the default printer driver.
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11 Click [Finish].

The installation is completed.
The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart 
my computer now.” and click [Finish] to restart your computer.

If you selected a temporary port in the Select Port screen in step 8, configure TCP/LPR 
port referring the following page:

 P.28 “Configuring the Raw TCP/LPR port”

Configuring the Raw TCP/LPR port

The procedure above is only for the case you select a temporary port. If you do not select a tem-
porary port, the procedure is not necessary.

1 Click [Start] and then [Devices and Printers] to open the Devices 
and Printers folder.
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2 Right-click on the printer driver icon, and then select [Printer prop-
erties] from the menu.

The printer driver properties dialog box appears.

3 Display the [Ports] tab and click [Add Port...].

The Printer Ports dialog box appears.

4 Select “Standard TCP/IP Port” and click [New Port...].

The Add Standard TCP/IP Printer Port Wizard dialog box appears.
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5 Click [Next].

6 Enter the IP address of this equipment in the “Printer Name or IP 
Address” field and click [Next].

If your network uses a DNS or WINS server, enter the printer name of this equipment 
provided from DNS or WINS in the “Printer Name or IP Address” field.
In the “Port Name” field, the port name is automatically entered according to the IP 
address or DNS name entered in the “Printer Name or IP Address” field.

7 Select “Standard” and click [Next].
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When the LPD Print setting is enabled, you can also configure LPR printing. When you want to 
configure LPR printing, follow the procedure below.
You can also select [Printer properties] and set the port with [Configure Port...] in the [Ports] tab 
by right-clicking the printer driver in the [Devices and Printers] folder.

Select “Custom” and click [Settings].

Select “LPR” at the “Protocol” option, enter “Print” in the “Queue Name” field at the “LPR Set-
tings” option, and then click [OK].

Click [Next].
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8 Click [Finish].

The screen returns to the Printer Ports dialog box.

9 Click [Close] to close the Printer Ports dialog box.

10 Make sure the created Raw TCP or LPR port is checked in the “Print 
to the following port(s)” list and click [Close].

Before using the printer driver for printing, please configure the installed options of the 
equipment and department code (if required) on the printer driver.

 P.88 “Before using the printer driver”
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Installation for Raw TCP/LPR Printing by Add Printer Wizard

Before proceeding to this section, you must logon Windows with a user account that allows you 
to install or uninstall client software (e.g. administrator privilege). If you are using Windows 7, 
you can temporarily change your user account to the one noted above with its User Account 
Control function. Ask your administrator for the details.

Installing the printer driver for Raw TCP/LPR printing by Add Printer Wizard

1 Click [Start] and then [Devices and Printers] to open the Devices 
and Printers folder.

2 Click [Add a printer].

The Add Printer dialog box appears.
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3 Select [Add a local printer] and click [Next].

4 Select “Create a new port” and select “Standard TCP/IP Port” in the 
“Type of port” drop down box. Then click [Next].
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5 Enter the IP address of this equipment in the “Hostname or IP 
address” field and click [Next].

If your network uses a DNS or WINS server, enter the printer name of this equipment 
provided from DNS or WINS in the “Hostname or IP address” field.
In the “Port name” field, the port name is automatically entered according to the IP 
address or DNS name entered in the “Hostname or IP address” field.
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6 Select “Standard” and click [Next].

When the LPD Print setting is enabled, you can also configure LPR printing. When you 
want to configure LPR printing, follow the procedure below.
You can also select [Printer properties] and set the port with [Configure Port...] in the 
[Ports] tab by right-clicking the printer driver in the [Devices and Printers] folder.

Select “Custom” and click [Settings].
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Select “LPR” at the “Protocol” option, enter “Print” in the “Queue Name” field at the “LPR 
Settings” option, and then click [OK].

Click [Next].

7 Click [Have Disk...].

The Install From Disk dialog box appears.
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8 Click [Browse...].

The Locate File dialog box appears.

9 Insert the Client Utilities CD-ROM into the CD-ROM drive.
When inserting the Client Utilities CD-ROM, the installer may automatically start. Click 
[Cancel] to exit the installer and continue the operation.

10 Open the folder where the printer driver for Windows 7 is located, 
and select an INF file, and then click [Open].

To install the PCL6 printer driver, locate 
"[Client Utilities CD-ROM]:\W2K_XP_VISTA\PCL6\<language>".
To install the PS3 printer driver, locate 
"[Client Utilities CD-ROM]:\W2K_XP_VISTA\PS\<language>".

When using Windows 7 64-bit edition, select the following folder.
To install the PCL6 printer driver, locate 
"[Client Utilities CD-ROM]:\XP_VISTA_X64\PCL6\<language>".
To install the PS3 printer driver, locate 
"[Client Utilities CD-ROM]:\XP_VISTA_X64\PS\<language>".

11 Click [OK].
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12 Select the printer driver and click [Next].

If the same printer driver has been installed, the following dialog box appears. Select 
“Replace the current driver” and click [Next].

13 Change the name if desired and click [Next].
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14 Click [Finish].

Click [Print a test page] to print a test page.

If any printer drivers have been installed on your computer, the following dialog box 
appears. Please select whether you will use this printer as a default printer.

15 The installation is completed.

Before using the printer driver for printing, please configure the installed options of the 
equipment and department code (if required) on the printer driver.

 P.88 “Before using the printer driver”
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Installing client software for IPP printing
This section describes how to set up the printer drivers for IPP printing which is available for 
Internet connection.
To set up the printer drivers for IPP printing, install the printer drivers by Add Printer Wizard, and 
then install the other software that you require.

Before installing the printer driver for IPP printing, check with your system administrator to make 
sure of the following:

This equipment is connected to the network and turned on.
The TCP/IP setting is correct on this equipment and your computer.

Installation for IPP printing by Add Printer Wizard

Installing the printer driver for IPP printing by Add Printer Wizard

Before proceeding to this section, you must logon Windows with a user account that allows you 
to install or uninstall client software (e.g. administrator privilege). If you are using Windows 7, 
you can temporarily change your user account to the one noted above with its User Account 
Control function. Ask your administrator for the details.

1 Click [Start] and then [Devices and Printers] to open the Devices 
and Printers folder.
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2 Click [Add a printer].

The Add Printer dialog box appears.

3 Click [Add a network, wireless or Bluetooth printer].

4 Click [The printer that I want isn’t listed].
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5 Select the "Select a shared printer by name" and enter "http://[IP 
address]:631/Print" in the edit box.

Enter the IP address of this equipment instead of [IP address].
   Example: IP address = 10.10.70.120

http://10.10.70.120:631/Print
If your network uses a DNS or WINS server, enter the printer name of this equipment 
provided from DNS or WINS instead of [IP address].
   Example: Print Server Name = Mfp-00c67861

http://Mfp-00c67861:631/Print
When you connect from the Internet, enter the FQDN of this equipment provided from 
DNS instead of [IP address].
   Example: URL = mfp_00c67861.toshiba.com

http://mfp_00c67861.toshiba.com:631/Print

“P” for “Print” in the IPP URL must be capitalized. When you are using on Windows 7, the 
IPP port can be created by entering “print” (non-capitalized) in the IPP URL, but the print 
job cannot be sent to the equipment. In that case, delete the IPP port and then create the 
IPP port correctly again.

If an administrator has enabled the IPP Port80 Enabled option on this equipment, you 
can exclude the port number from the URL. (i.e. “http://192.168.255.48/Print”)
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6 Click [Next].
A dialog box appears to confirm the connection with the specified MFP. Wait until 
completion.

When the Authentication setting for IPP Print is enabled, the dialog box to enter a user 
name and password appears. If this dialog box appears, enter the user name and pass-
word and click [OK]. For user name and password, please ask your administrator.

7 Click [Have Disk...].

The Install From Disk dialog box appears.

8 Click [Browse...].

The Locate File dialog box appears.
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9 Insert the Client Utilities CD-ROM into the CD-ROM drive.
When inserting the Client Utilities CD-ROM, the installer may automatically start. Click 
[Cancel] to exit the installer and continue the operation.

10 Open the folder where the printer driver for Windows 7 is located, 
and select an INF file, and then click [Open].

To install the PCL6 printer driver for Windows 7, 
locate "[Client Utilities CD-ROM]:\W2K_XP_VISTA\PCL6\<language>".
To install the PS3 printer driver for Windows 7, 
locate "[Client Utilities CD-ROM]:\W2K_XP_VISTA\PS\<language>".

When using Windows 7 64-bit edition, select the following folder.
To install the PCL6 printer driver, locate 
"[Client Utilities CD-ROM]:\XP_VISTA_X64\PCL6\<language>".
To install the PS3 printer driver, locate 
"[Client Utilities CD-ROM]:\XP_VISTA_X64\PS\<language>".

11 Click [OK].
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12 Select the printer driver and click [Next].

If the user account control is enabled, the [Installing device driver] dialog box is dis-
played. Click [Continue] to continue the installation.
When the [Windows Security] dialog box is displayed, click [Install this driversoftware 
anyway] to continue the installation.

13 Click [Next].
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14 Click [Finish].

Click [Print a test page] to print a test page.

If any printer drivers have been installed on your computer, the following dialog box 
appears. Please select whether you will use this printer as a default printer.

Before using the printer driver for printing, please configure the installed options of the 
equipment and department code (if required) on the printer driver.

 P.88 “Before using the printer driver”
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Uninstalling client utilities software
The following instructions describe how to uninstall the client software. The uninstallation proce-
dure is different how you installed the client software.

 P.48 “When installed using the installer”
 P.53 “When installed using Add Printer Wizard”

When installed using the installer
When the client software was installed using the Installer in the Client Utilities CD-ROM, you can 
delete all files using the Add/Remove Programs function.
You can uninstall all client software that have installed from the Client Utilities CD-ROM, or you 
can uninstall only the components that you want to remove.

 P.48 “Uninstalling all client utilities software”
 P.50 “Uninstalling only the components that you want to remove”

Uninstalling all client utilities software

1 Open “Control Panel” and select “Uninstall a program”.

The Uninstall or change a program dialog box appears.
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2 Select “TOSHIBA e-STUDIO205 Series Client” and click [Uninstall] 
or [Change].

The InstallShield Wizard dialog box appears.

3 Select “Remove” and click [Next].

The Confirm Uninstall dialog box appears.

4 Click [OK].
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5 Select “Yes, I want to restart my computer now.” and click [Finish] 
to restart your computer.

Some files may be deleted after restarting the computer.

Uninstalling only the components that you want to remove

When you want to uninstall only the printer drivers, follow the procedures below.

1 Open “Control Panel” and click the “Uninstall a program” icon.

The Uninstall or change a program dialog box appears.
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2 Select “TOSHIBA e-STUDIO205 Series Client” and click [Uninstall] 
or [Change].

The InstallShield Wizard dialog box appears.

3 Select “Modify” and click [Next].

4 Uncheck the components that you want to uninstall and click 
[Next].
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5 Select “Yes, I want to restart my computer now.” and click [Finish] 
to restart your computer.

Some files may be deleted after restarting the computer.
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When installed using Add Printer Wizard
If only printer drivers are installed by Add Printer Wizard or Point and Print, you can uninstall 
them by deleting the printer icons from the Devices and Printers folder.

Deleting printer drivers

1 Click [Start] and then [Devices and Printers] to open the Devices 
and Printers folder.

2 Select the printer driver icon, and select [Print server properties].

The Print Server Properties dialog box appears.
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3 Select the [Drivers] tab. Select the printer drivers that you want to 
delete, and click [Remove...].

The Remove Driver And Package dialog box appears.

4 Select “Remove driver and driver package.” and click [OK].

The confirmation dialog box appears.

5 Click [Yes].

The printer drivers are completely deleted.
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Installing Client Software for Macintosh

Please refer to following instructions for configuring printing systems on Macintosh computers.
 P.55 “About client software for Macintosh”
 P.55 “Planning for installation”
 P.57 “Installing the printer on Mac OS X 10.2.4 to Mac OS X 10.6.x”

About client software for Macintosh

PostScript Printer Description file
The Macintosh PPD (PostScript Printer Description) file contains information about controller-
specific features. There is a PPD files provided in the Client Utilities CD-ROM: it is for 
Mac OS X.
Information within the PPD file for Mac OS X works in conjunction with the Print Center on 
Mac OS X 10.2.4 to Mac OS X 10.6.x.

Planning for installation

System requirements
To install the printer drivers on a Mac OS computer, the following environment is required.
Display Resolution: 1028 x 768 dots or more
OS: Mac OS X 10.2.4 to Mac OS X 10.6.x
Protocol: TCP/IP, AppleTalk (Ethernet), Bonjour
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Installation procedure list for Macintosh client software
The following table shows the procedure list to install the PPD files and configure the printers.

OS Description Refer to
Mac OS X 10.2.4 
to 10.3.x

PPD file installation  P.57 “Installing the Macintosh PPD file on 
Mac OS X 10.2.4 to 10.3.x”

IP printing  P.65 “Configuring Macintosh LPR printing 
on Mac OS X 10.2.4 to 10.3.x”

IPP printing  P.67 “Configuring Macintosh IPP printing 
on Mac OS X 10.2.4 to 10.3.x”

AppleTalk/Bonjour printing  P.69 “Configuring Macintosh AppleTalk/
Bonjour printing on Mac OS X 10.2.4 to 10.3.x”

Mac OS X 10.4.x PPD file installation  P.61 “Installing the Macintosh PPD file on 
Mac OS X 10.4.x to 10.6.x”

IP printing  P.72 “Configuring Macintosh IP printing on 
Mac OS X 10.4.x”

IPP printing  P.73 “Configuring Macintosh IPP printing 
on Mac OS X 10.4.x”

AppleTalk/Bonjour printing  P.75 “Configuring Macintosh AppleTalk/
Bonjour printing on Mac OS X 10.4.x”

Mac OS X 10.5.x to 
10.6.x

PPD file installation  P.61 “Installing the Macintosh PPD file on 
Mac OS X 10.4.x to 10.6.x”

IP printing  P.78 “Configuring Macintosh IP printing on 
Mac OS X 10.5.x to 10.6.x”

IPP printing  P.80 “Configuring Macintosh IPP printing 
on Mac OS X 10.5.x to 10.6.x”

Bonjour printing  P.82 “Configuring Macintosh Bonjour print-
ing on Mac OS X 10.5.x to 10.6.x”
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Installing the printer on Mac OS X 10.2.4 to Mac OS X 10.6.x
Install and configure the printer by the following steps:

 P.57 “Installing the Macintosh PPD file on Mac OS X 10.2.4 to 10.3.x”
 P.61 “Installing the Macintosh PPD file on Mac OS X 10.4.x to 10.6.x”
 P.64 “Configuring the printer on Mac OS X 10.2.4 to 10.3.x”
 P.72 “Configuring the printer on Mac OS X 10.4.x”
 P.78 “Configuring the printer on Mac OS X 10.5.x to 10.6.x”
 P.84 “Configuring the installable options”

Installing the Macintosh PPD file on Mac OS X 10.2.4 to 10.3.x

Installing the PPD file to Mac OS X

The timing that the Authenticate dialog box to enter your name and password appears differs 
depending on the version of your OS.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive and open 
the “MacPPD:OSX:10_2-10_3” folder.

2 Copy the GZ file (TOSHIBA_e-ST205Srs.dmg.gz) to the desktop.

3 Double-click the GZ file on the desktop.
If the installer window does appear, go to step 5.

4 Double-click the Disk Image file (TOSHIBA_e-ST205Srs.dmg).
The installer window appears.

5 Double-click the icon in the installer window.

The welcome message is displayed.
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6 Click [Continue].

The Software License Agreement window is displayed.

7 Click [Continue].

8 Click [Agree].

The Select a Destination window is displayed.
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9 Select the boot hard disk of your Mac OS X and click [Continue].

The Easy Install window is displayed.

10 Click [Install] (or [Upgrade]).

It start copying the PPD files for each language.

11 Enter the name and password, and click [OK].

The Install Software window is displayed.

When this is being installed in Mac OS X 10.2.4 to 10.2.8, this dialog box is not dis-
played.
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12 Click [Close] to close the installer window.

13 Delete the GZIP files and Installer files created from the desktop.

14 Continue the procedure for configuring the printer.
 P.64 “Configuring the printer on Mac OS X 10.2.4 to 10.3.x”
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Installing the Macintosh PPD file on Mac OS X 10.4.x to 10.6.x

Installing the PPD file to Mac OS X

The timing that the Authenticate dialog box to enter your name and password appears differs 
depending on the version of your OS.

1 Insert the Client Utilities CD-ROM into the CD-ROM drive and open 
the “MacPPD:OSX:10_4-” folder.

2 Copy the GZ file (TOSHIBA_eS205Series.dmg.gz) to the desktop.

3 Double-click the GZ file on the desktop.
If the installer window does appear, go to step 5.

4 Double-click the Disk Image file (TOSHIBA_eS205Series.dmg).
The installer window appears.

5 Double-click the icon in the installer window.

The welcome message is displayed.

6 Click [Continue].

The Software License Agreement window is displayed.
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7 Click [Continue].

8 Click [Agree].

The Select a Destination window is displayed.

9 Select the boot hard disk of your Mac OS X and click [Continue].

The Easy Install window is displayed.
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10 Click [Install] (or [Upgrade]).

It start copying the PPD files for each language.

11 Enter the name and password, and click [OK].

The Install Software window is displayed.

12 Click [Close] to close the installer window.

13 Delete the GZIP files and Installer files created from the desktop.

14 Continue the procedure for configuring the printer.
 P.72 “Configuring the printer on Mac OS X 10.4.x”
 P.78 “Configuring the printer on Mac OS X 10.5.x to 10.6.x”
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Configuring the printer on Mac OS X 10.2.4 to 10.3.x
This equipment supports the following Macintosh Printing Services: LPR printing, IPP printing, 
AppleTalk printing and Bonjour printing. 

LPR printing
When this equipment and your computer are connected over the TCP/IP network, you can 
enable LPR printing from a Macintosh computer.
IPP printing
When this equipment and your computer are connected over the TCP/IP network, you can 
enable IPP printing from a Macintosh computer.
AppleTalk printing
When this equipment and your computer are connected over the AppleTalk network, you can 
enable AppleTalk printing from a Macintosh computer.
Bonjour printing (only for Mac OS X 10.3.x)
When this equipment and your computer are connected over the TCP/IP network, you can 
enable Bonjour printing from a Macintosh computer.
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Configuring Macintosh LPR printing on Mac OS X 10.2.4 to 10.3.x

Before installing the printer driver for LPR printing, check with your system administrator to 
make sure of the following:
- This equipment is connected to the network and turned on. 
- The TCP/IP setting is correct.
- LPD Printing Service is enabled on this equipment. Ask your administrator if the LPD Printing 

Service is enabled.

1 Start the Print Center (for Mac OS X 10.2.4 to 10.2.8) or Printer Setup 
Utility (for Mac OS X 10.3.x), located in the “Applications:Utilities” 
folder in the Boot Disk.

The Printer List dialog box appears.

2 Click [Add].

3 Select “IP Printing” in the drop down box.
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4 Enter the IP address or DNS name of this equipment in the 
“Printer’s Address” field.

5 Uncheck the “Use default queue on server” box and enter “Print” in 
the “Queue Name” field.

6 Select “TOSHIBA” at the “Printer Model” drop down box, and select 
the PPD file.

7 Click [Add].
The printer is added to the Printer List.

8 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”
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Configuring Macintosh IPP printing on Mac OS X 10.2.4 to 10.3.x

Before installing the printer driver for IPP printing, check with your system administrator to make 
sure of the following:
- This equipment is connected to the network and turned on. 
- IPP Printing Service is enabled on this equipment. Ask your administrator if the IPP Printing 

Service is enabled.

1 Start the Print Center (for Mac OS X 10.2.4 to 10.2.8) or Printer Setup 
Utility (for Mac OS X 10.3.x), located in the “Applications:Utilities” 
folder in the Boot Disk.

The Printer List dialog box appears.

2 Click [Add] while pressing the [option] button.

This is mandatory to show all the advanced print option in the drop down box in the Print 
List window.



2 INSTALLING CLIENT SOFTWARE <GA-1191>

68    Installing Client Software for Macintosh

3 Select “Advanced” in the drop down box and specify the items as 
described below.

Device: Internet Printing Protocol (http)
Device Name: <Any Name>
Device URI: http://<IP address>:631/Print
Printer Model: TOSHIBA
PPD: TOSHIBA e-STUDIO205 Series PS

4 Click [Add].
The printer is added to the Printer List.

5 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”
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Configuring Macintosh AppleTalk/Bonjour printing on Mac OS X 10.2.4 to 
10.3.x

Before installing the printer driver for AppleTalk/Bonjour printing, check with your system admin-
istrator to make sure of the following:
- This equipment is connected to the network and turned on. 
- AppleTalk/Bonjour is enabled on this equipment. Ask your administrator if AppleTalk/Bonjour 

is enabled. 

1 Start the Print Center (for Mac OS X 10.2.4 to 10.2.8) or Printer Setup 
Utility (for Mac OS X 10.3.x), located “Applications:Utilities” folder 
in the Boot Disk.

The Printer List dialog box appears.

2 Click [Add].
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3 Select “AppleTalk”/“Bonjour (Rendezvous)” in the drop down box.
When you select “AppleTalk”: Go to step 4.

When you select “Bonjour”: Go to step 5.

4 When you select “AppleTalk”, select a zone where this equipment 
is located.

If the AppleTalk network is not configured with a zone, select “Local AppleTalk Zone”.

5 Select this equipment displayed in the list.
Example of when you select AppleTalk:
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6 Select “TOSHIBA” at the “Printer Model” drop down box, and select 
the PPD file.
Example of when you select AppleTalk:

7 Click [Add].
The printer is added to the Printer List.

8 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”
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Configuring the printer on Mac OS X 10.4.x
After you copy the PPD file to the library folder in the System Folder, you can configure the 
printer. 
This equipment supports the following Macintosh Printing Services: LPR printing, IPP printing, 
AppleTalk printing and Bonjour printing.

LPR printing
When this equipment and your computer are connected over the TCP/IP network, you can 
enable LPR printing from a Macintosh computer.
IPP printing
When this equipment and your computer are connected over the TCP/IP network, you can 
enable IPP printing from a Macintosh computer.
AppleTalk printing
When this equipment and your computer are connected over the AppleTalk network, you can 
enable AppleTalk printing from a Macintosh computer.
Bonjour printing 
When this equipment and your computer are connected over the TCP/IP network, you can 
enable Bonjour printing from a Macintosh computer.

Configuring Macintosh IP printing on Mac OS X 10.4.x

Before installing the printer driver for IP printing, check with your system administrator to make 
sure of the following:
- This equipment is connected to the network and turned on.
- The TCP/IP setting is correct.
- LPD Printing Service is enabled on this equipment. Ask your administrator if the LPD Printing 

Service is enabled.

1 Start the Printer Setup Utility located in the “Applications:Utilities” 
folder in the Boot Disk.

The Printer List dialog box appears.
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2 Click [Add].

The Printer Browser dialog box appears.

3 Click [IP Printer] and select “Line Printer Daemon - LPD” in the 
drop down box.

4 Specify the items described below.
Address: IP address or DNS name
Queue: Print
Name: <Any Name> 

(The content of the “Address” field automatically appears in this field.)
Location: <Any Location>
Print Using: TOSHIBA
PPD: TOSHIBA eS205Seriese

5 Click [Add].

6 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”

7 Click [Continue].
The printer is added to the Printer List.

Configuring Macintosh IPP printing on Mac OS X 10.4.x

Before installing the printer driver for IPP printing, check with your system administrator to make 
sure of the following:
- This equipment is connected to the network and turned on.
- IPP Printing Service is enabled on this equipment. Ask your administrator if the IPP Printing 

Service is enabled.
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1 Start the Printer Setup Utility located in the “Applications:Utilities” 
folder in the Boot Disk.

The Printer List dialog box appears.

2 Click [Add].

The Printer Browser dialog box appears.

3 Click [IP Printer] and select “Internet Printing Protocol - IPP” in the 
drop down box.

4 Specify the items described below.
Address: IP address or DNS name
Queue: Print
Name: <Any Name> 

(The content of the “Address” field automatically appears in this field.)
Location: <Any Location>
Print Using: TOSHIBA
PPD: TOSHIBA eS205Seriese
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5 Click [Add]. 

6 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”

7 Click [Continue].
The printer is added to the Printer List.

Configuring Macintosh AppleTalk/Bonjour printing on Mac OS X 10.4.x

Before installing the printer driver for AppleTalk/ Bonjour printing, check with your system admin-
istrator to make sure of the following:
- This equipment is connected to the network and turned on. 
- AppleTalk/Bonjour is enabled on this equipment. Ask your administrator if AppleTalk/Bonjour 

is enabled.

1 Start the Printer Setup Utility located in the “Applications:Utilities” 
folder in the Boot Disk.

The Printer List dialog box appears.

2 Click [Add].

The Printer Browser dialog box appears.
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3 Click [Default Browser].

4 Select a printer name for AppleTalk/Bonjour in the “Printer Name” 
field.
When you select AppleTalk:

Enter the name of this equipment in the “Name” field as required. (The content of the 
“Address” field automatically appears in this field.)
If you did not use the AppleTalk network zone for AppleTalk setting, “Local Zone” appears 
in the “Location” field.
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If you used the AppleTalk network zone for AppleTalk setting, select a zone where this 
equipment is located in the “Location” drop down box.

When you select Bonjour:

Enter the name of this equipment in the “Name” field as required. (The content of the 
“Address” field automatically appears in this field.)

5 Select “TOSHIBA” at the “Print Using” drop down box, and select 
the PPD file (TOSHIBA eS205Series).
Example of when you select AppleTalk:

6 Click [Add]. 

7 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”

8 Click [Continue].
The printer is added to the Printer List.



2 INSTALLING CLIENT SOFTWARE <GA-1191>

78    Installing Client Software for Macintosh

Configuring the printer on Mac OS X 10.5.x to 10.6.x
After you copy the PPD file to the library folder in the System Folder, you can configure the 
printer.
This equipment supports the following Macintosh Printing Services: LPR Printing, AppleTalk 
Printing, IPP Printing and Bonjour Printing.

LPR printing
When this equipment and your computer are connected over TCP/IP network, you can per-
form LPR printing from Macintosh computer.
IPP printing
When this equipment and your computer are connected over TCP/IP network, you can per-
form IPP printing from Macintosh computer.
Bonjour printing
When this equipment and your computer are connected over TCP/IP network, you can per-
form Bonjour printing from Macintosh computer.

Configuring Macintosh IP printing on Mac OS X 10.5.x to 10.6.x

1 Open “System Preferences” and click [Print & Fax].

2 Click [+].
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3 Click [IP] and specify the items as described below.

Protocol: Line Printer Daemon - LPD
Address: <IP address or DNS name of this equipment>
Queue: print
Name: <Any Name>
Location: <Any Location>
Print Using: TOSHIBA eS205Series

In the [Name] box, the name that is entered in the [Address] box is automatically dis-
played.
When you enter the IP address or DNS name of this equipment in the [Address] box, 
the correct PPD file is not selected in the [Print Using] box. Therefore, select [Other] 
in the [Print Using] box, and select the PPD file (TOSHIBA eS205Series) from the 
[/Library/Printers/PPDs/Contents/Resources/<language>.lproj].

4 Click [Add].
The [Installable Options] window appears.

5 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring Macintosh IPP printing on Mac OS X 10.5.x to 10.6.x

When you want to setup IPP print queue in the Mac OS X, follow the procedures below.

1 Open “System Preferences” and click [Print & Fax].

2 Click [+].
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3 Click [IP] and specify the items as described below.

Protocol: Internet Printing Protocol - IPP
Address: <IP address or DNS name of this equipment>
Queue: Print
Name: <Any Name>
Location: <Any Location>
Print Using:  TOSHIBA eS205Series

In the [Name] box, the name that is entered in the [Address] box is automatically dis-
played.
When you enter the IP address or DNS name of this equipment in the [Address] box, 
the correct PPD file is not selected in the [Print Using] box. Therefore, select [Other] 
in the [Print Using] box, and select the PPD file (TOSHIBA eS205Series) from the 
[/Library/Printers/PPDs/Contents/Resources/<language>.lproj].

4 Click [Add].
The Installable Options window appears.

5 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring Macintosh Bonjour printing on Mac OS X 10.5.x to 10.6.x

1 Open “System Preferences” and click [Print & Fax].

2 Click [+].
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3 Click [Default] and select the TOSHIBA MFP of the Bonjour connec-
tion displayed in the list.

In the [Name] box, the device name that you selected in the list is automatically dis-
played.
Even when you select the equipment from the list, the correct PPD file is not selected 
in the [Print Using] box. Therefore, select [Other] in the [Print Using] box, and select 
the PPD file (TOSHIBA eS205Series) from the [/Library/Printers/PPDs/Contents/
Resources/<language>.lproj].

4 Click [Add].
The [Installable Options] window appears.

5 Continue the procedure to configure the installable options.
 P.84 “Configuring the installable options”

6 Click [Continue].
The printer is added to the Printer List.
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Configuring the installable options
Users must configure the installable options before printing.

Configure the installable options for each printing system.

Configuring the installable options

1 In the Printer List dialog box, select the printer and, then, select 
[Show Info] in the [Printers] menu.

The Printer Info dialog box appears.

2 Select “Installable Options” in the drop down menu.

The Installable Options window is displayed.
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3 Set the following options.

Drawers
Not Installed – Select this when no optional paper feed unit is installed.
Drawer 2 – Select this when only the Paper Feed Unit (optional) is installed.
Drawer 2 & 3 – Select this when the Paper Feed Unit (optional) and Paper Feed Pedestal 
(optional, its upper Drawer only) are installed.
Drawer 2, 3 & 4 – Select this when the Paper Feed Unit (optional) and Paper Feed 
Pedestal (optional, both of its upper and lower Drawers) are installed.
ADU
Not Installed – Select this when the Automatic Duplexing Unit (optional) is not installed.
Installed – Select this when the Automatic Duplexing Unit (optional) is installed.

4 Click [Apply Changes] and close the window.



2 INSTALLING CLIENT SOFTWARE <GA-1191>

86    Uninstalling Macintosh PPD

Uninstalling Macintosh PPD

To uninstall Macintosh PPD, delete PPD files in the following folder.

For Mac OS X 10.2.4 to 10.3.x
Library/Printers/PPDs/Contents/Resources/<language>.lproj/TOSHIBA_e-ST205Srs.gz

For MAC OS X 10.4.x to 10.6.x
Library/Printers/PPDs/Contents/Resources/TOSHIBA_eS205Series.gz
Library/Printers/PPDs/Contents/Resources/<language>.lproj/TOSHIBA_eS205Series.gz
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Printing from Windows

This equipment supports printing from Windows applications using the PCL6 and PS3 printer 
drivers.
These printer drivers allow you to define such document properties as the orientation and print 
quality of your pages, and such complex finishing options as booklet layout and N-up printing.

Before using the printer driver
Before printing, you have to configure the following options:

Configuration Settings
You have to configure such options as the Paper Feed Unit or the Paper Feed Pedestal. The 
features of these options are not available unless you tell the system that they are installed.
Department Code
This system can manage jobs by department code. This feature lets you manage job 
counters for every department code. For example, a network administrator can check the 
number of copies printed from specific department member.
If the Department Code is enabled, enter your Department Code provided by your adminis-
trator.

Configuring the options
After you complete the installation of the printer drivers, you should configure the option settings 
on the printer drivers.
There are two methods to configure the options;

If this equipment and your computer are not connected in the TCP/IP network, you can con-
figure the options manually.

 P.89 “Configuring the options manually”
If this equipment and your computer are connected in the TCP/IP network, you can configure 
the options automatically obtaining the settings using the SNMP Communication.

 P.91 “Configuring the Options Automatically”
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— Configuring the options manually

Setting the configuration tab manually

Before proceeding to this section, you must logon Windows with a user account that allows you 
to install or uninstall client software (e.g. administrator privilege). If you are using Windows 7, 
you can temporarily change your user account to the one noted above with its User Account 
Control function. Ask your administrator for the details.

1 Right-click on the printer driver icon in the Devices and Printers 
folder, and then select [Printer properties] from the menu.

For Windows 7, some tab menus have a  button in the printer driver properties. To 
change the properties, click on it. If the properties cannot be changed, ask your system 
administrator.
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2 Display the [Configuration] tab and set the following options.

Option - Model Selection: Select a model name.
Option - Automatic Duplexing Unit: Check this when the Automatic Duplexing Unit 
(optional) is installed.
Drawers: Select the current drawer configuration.

For more information about each item, see descriptions about the Configuration Tab.
 P.119 “Configuration tab”

3 Click [Drawer Settings].
The Drawer Settings dialog box appears.

4 Set the following options and click [OK].

Paper Size
Select the paper size set in each drawer.

Paper Type
Select the paper type set in each drawer. The paper types for the 1st drawer to 4th 
drawer are fixed to “Plain”.

5 Click [Apply] and [OK] to save settings.
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— Configuring the Options Automatically

Setting the configuration tab using SNMP communication

Before proceeding to this section, you must logon Windows with a user account that allows you 
to install or uninstall client software (e.g. administrator privilege). If you are using Windows 7, 
you can temporarily change your user account to the one noted above with its User Account 
Control function. Ask your administrator for the details.

1 Right-click on the printer driver icon in the Devices and Printers 
folder, and then select [Printer properties] from the menu.
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2 Display the [Configuration] tab, check on “Enable SNMP Communi-
cation”, and click [Update Now].

The printer driver starts communicating with system and obtains option settings 
automatically.

If the connection to the equipment has not been configured correctly, the SNMP commu-
nication fails and the option settings will not be updated.

3 If you want to update option settings automatically when the [Con-
figuration] tab is opened, check on “Update Automatically”.

4 Click [Apply] and [OK] to save settings.

For more information about each item, see descriptions about the Configuration Tab.
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Setting the department code
When this equipment is managed by department codes, you have to enter your department 
code on the printer driver.
This allows a network administrator to check the number of copies printed from specific depart-
ment members. 
Please ask your administrator whether or not you should enter the Department Code.
If you enter the department code in "Department" of the printer driver in advance following the 
procedure below, you do not have to enter it every time you begin printing.

If printing is performed with an incorrect department code, a dialog box indicating that it is 
incorrect appears. In this case, enter the correct one or stop transmitting. If this dialog box 
does not appear, the job becomes invalid and is deleted. An error report is then printed out 
from this equipment. (If the “Enable SNMP Communication” check box of the Configuration 
tab menu of the printer is checked, an error message appears before the job is deleted.
A department code can be entered every time you begin printing. If you have to use a differ-
ent department code for each print job, enter it when you begin printing.

Entering department code

1 Right-click on the printer driver icon in the Devices and Printers 
folder, and then select [Printing preferences] from the menu.

The printer driver properties dialog box appears.
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2 Display the [Others] tab and enter your department code in the 
“Department” field.

In the Department field, only numeric characters can be entered. The Department Code 
must be 5-digit number.

3 Click [Apply] and [OK] to save settings.

Copying the PPD file for Windows
The Client Utilities CD-ROM contains a printer description file for popular Windows applications. 
PageMaker 6.0, 6.5, and 7.0 do not support automatic installation of printer description files. To 
make printing available in the Print and Page Setup dialog boxes of this application, copy the 
printer description file to the appropriate location.

Copying the printer description file

1 On the Client Utilities CD-ROM, open the folder that contains the 
PS3 printer driver.

For Windows 7:
[Client Utilities CD-ROM]:\W2K_XP_VISTA\PS\<language>\
For Windows 7 64-bit edition:
[Client Utilities CD-ROM]:\XP_VISTA_X64\PS\<language>\

2 Copy the printer description file (*.ppd) to the appropriate location.
For PageMaker 6.0:
\PM6\RSRC\<language>\PPD4
For PageMaker 6.5:
\PM65\RSRC\<language>\PPD4
For PageMaker 7.0:
\Program Files\Adobe\PageMaker 7.0\Rsrc\<language>\PPD4
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Printing from application
The following describes how to print from your application.

 P.95 “Considerations and limitations”
 P.95 “How to print”

Considerations and limitations
Some options listed in the printer driver can also be set from an application (for example, col-
lation). However, using collation in the application may cause problems. In that case, use the 
driver option to perform the function, rather than setting it from the application. But depend-
ing on the application, settings such as the orientation may need to be set in the application, 
or the printer driver, or both. The application may not set up the file properly for printing on 
this equipment and may also take longer to process. In order to print properly from the appli-
cation that you are using, please see the section about printing in the application’s manual.

When printing with the PS3 printer driver from Adobe Acrobat, the Fit to Paper enlargement 
feature does not work if the “Use PostScript Passthrough” option is enabled in the PostScript 
settings of the PS3 printer driver. To use the Fit to Paper enlargement feature, please disable 
the “Use PostScript Passthrough” option in the PostScript settings of the PS3 printer driver.

When printing with the PS3 printer driver from the application that creates the PostScript 
code for printing such as Adobe Acrobat, the following print options may not work correctly. 
In that case, please disable the “Use PostScript Passthrough” option in the PostScript set-
tings of the PS3 printer driver.
- Manual Scale
- Print Paper Size
- Paper Type
- User Front Cover
- User Back Cover
- Booklet
- Multiple Pages per Sheet
- All options in the Effect tab
- All options in the Image Quality tab

How to print
Once you have installed the printer driver and configured it properly, you can print directly from 
most Windows applications. Simply choose the Print command from within your application.
You can print using the various functions by setting print options on the printer driver.

Printing from Windows applications

 Adobe Reader is used as an Windows application.

1 Open a file and select [Print] from the [File] menu of the application.
The Print dialog box appears.
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2 Select the printer driver of the equipment to be used and Click 
[Properties].

The printer properties dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different 
depending on an application that you are using. See your application’s manual about dis-
playing the printer properties dialog box.

3 Setting the Print Options for each tab according to how you want to 
print.

Setting the print options varies depending on how you want to print a document.
 P.101 “Print options”

You can also set the print options using setting profiles.
 P.98 “Setting print options for each print job”

4 Click [OK] to save the settings.
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5 Click [OK] or [Print] to print a document.

When the department management is enabled, if printing is performed with an incor-
rect department code, a dialog box indicating that it is incorrect appears. In this case, 
enter the correct one or stop transmitting. If this dialog box does not appear, the job 
becomes invalid and is deleted. An error report is then printed out from this equip-
ment.
If the data size of a print job exceeds the memory capacity of this equipment, more 
than one set of documents with a large number of pages or a large volume of graph-
ics will not be printed in the correct set numbers. Only one set of the documents and 
an error report are printed out.
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Setting up print options
Print Options are the attributes you set to define the way a print job is processed. 

To find the printing instructions for your specific needs, refer to the procedures in the following 
section.

 P.121 “Printing with extended print functionality”

How to setup
There are several ways to set print options. Also, how the settings effect printing varies depend-
ing on the way you set the options. Also the tabs displayed vary depending on how you display 
the printer properties.

— Setting Initial values of print options
Setting the print options by displaying the printer properties from the Devices and Printers folder 
within the Windows Start menu will establish the initial values of the options. For example, the 
paper size setting you most commonly use, optional device settings, user information settings, 
etc., are settings you will not want to change every time you print. It is convenient to set these 
options as initial values.

1 Select [Start] and then [Devices and Printers].

2 Right-click on the printer driver icon, and then select [Printer prop-
erties] or [Printing preferences] from the menu.

— Setting print options for each print job
Setting the print options by displaying the printer properties from the Print dialog box within an 
application will establish the values for the current print job. The print option settings specific to 
each print job are set using this method.

How to display:

1 Click the [File] menu and select [Print] on an application.

2 Select the printer driver of the equipment to be used and Click 
[Properties].
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— Setting print options using profiles
Print option settings can be saved so you can easily load specifically configured settings for a 
particular job.
In order to print a document using profiles, you should create the saved profile first.

 P.99 “Saving profile”
Once you save profile, you can load the settings for a particular job to print a document.

 P.100 “Loading profile”
You can also delete the profile that you no longer require.

 P.100 “Deleting profile”

Saving profile

You can create up to 20 profiles for a printer driver.

1 Configure the print options on each tab.
Setting the print options varies depending on how you want to print a document.

 P.101 “Print options”

2 Click [Save Profile] at the Profile group.

The Profile Name dialog box appears.

3 Enter the profile name and click [OK].

The file name can be up to 63 characters long.

If you enter the existing profile name, it prompts whether overwrite the existing profile or 
not. If you want to overwrite the existing profile, click [OK].

4 The setting profile is saved.
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Loading profile

1 Select a profile in the “Profile” drop down box.

The settings profile is loaded from the file and apply to the printer options.

Selecting “None” in the “Profile” drop down box cannot restore the initial settings on the 
printer driver. To restore the initial settings after selecting a profile, click [Restore 
Defaults].

Deleting profile

1 Select a profile that you want to delete in the “Profile” drop down 
box, and click [Delete].

The Confirm Profile Delete dialog box appears.
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2 Click [Yes] to delete the selected profile.

Print options
This section describes print options in each tab of the printer driver. This section will help you to 
find the description of specific print options, or understand the functions for each print option.
The following example screen is displayed when you right-click on the printer driver icon and  
select [Printing preferences] from the menu in the Devices and Printers folder.

1) Printer name
Displays the name given to the printer driver when it was installed, or the name it displays on 
the icon in the Devices and Printers folder.

2) Menu tabs
The menu items of the printer driver are displayed as tabs. Clicking on a tab will display the 
contents of the selected tab. The tabs displayed vary depending on the way the print proper-
ties are displayed.
- Basic Tab

The Basic tab contains basic print operation settings, such as original paper size, print 
paper size, paper source, paper type, orientation, number of copies, and so on.

 P.103 “Basic tab”
- Finishing Tab

The Finishing tab allows you to enable sort printing, 2-sided printing, and N-up printing.
 P.105 “Finishing tab”

- Paper Handling Tab
The Paper Handling tab contains Cover page printing.

 P.109 “Paper Handling tab”

1

2
3

4

5

6

7 8 9 10
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- Image Quality tab
The Image Quality tab allows you to select how images are printed. You can easily select 
appropriate image quality depending on the type of job being printed.

 P.111 “Image Quality tab”
- Effect tab

The Effect tab contains print options that add the effects to your print jobs such as Water-
marks, Overlay Image printing, and so on.

 P.112 “Effect tab”
- Others Tab

The Others tab contains special features such as toner save and so on.
 P.116 “Others tab”

- Fonts tab
The Fonts tab allows you to select how the TrueType fonts are printed. This tab is only 
displayed when the printer properties are accessed from the Devices and Printers folder.

 P.118 “Fonts tab”
- Configuration tab

The Configuration tab allows you to configure the options. This tab is only displayed 
when the printer properties are accessed from the Devices and Printers folder.

 P.119 “Configuration tab”

3) Print Job
This sets the type of print job.
- Normal Print

Select this to print a job normally.
- Print to Overlay File

Select this to save the print job as an overlay file that is imposed on other documents. 
When you select this, click the button at the right and enter the file name. For example, if 
you want to print a master page image on the background of a document, you can create 
an overlay file of the master merge image using this option. Then you can print a docu-
ment using this overlay by specifying this file as an overlay image in the “Overlay Image” 
option of the Effect tab.

If the print job has several pages in the document, only the first page of the document will 
be saved as an overlay file.
Both the overlay file and the documents on which you superimpose the overlay image 
must be created at the same size.
When creating an overlay file using the PS3 printer driver from an application that can 
create the PS command directly, the overlay file will not be created properly. In that case, 
disable the “Use PostScript Passthrough” option in the PostScript Settings dialog box.

 P.117 “PostScript settings”

4) Preview window
In the Preview windows, you can check the current settings in the printer driver. You can 
change view type by clicking [Graphics] to display the print options settings graphically or 
[Text] to display the print options settings as a texts.

5) Profile
Print option settings can be saved on your hard disk. You can save print option settings by 
clicking [Save Profile] and easily load a setting file by selecting a profile name in the drop 
down menu.

 P.99 “Setting print options using profiles”

6) [Restore Defaults]
Click this to restore the settings to the original factory defaults.
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7) [OK]
Click this to enter the input settings and complete the print options settings.

8) [Cancel]
Click this to cancel the input settings and exit the print options settings.

9) [Apply]
Click this to enter the input settings without closing the print options settings. This button is 
only displayed when the printer properties are accessed from the Devices and Printers 
folder. This button remains grayed out until a setting is changed.

10) [Help]
Click this to browse the HELP for the printer driver.

— Basic tab
The Basic tab contains basic print operation settings, such as original paper size, print paper 
size, paper source, paper type, orientation, number of copies, and so on. Also this tab allows 
you to enable enlarge/reduce printing, sort printing, and 2-sided printing.

1) Original Paper Size
This selects the size of a document to be printed.

2) Print Paper Size
Select this to enlarge or reduce a page image to fit exactly in the selected paper size. If you 
do not enable enlarge or reduce printing, select “Same as Original Size”.

3) Manual Scale
Check this box to manually enter the zoom ratio, to enlarge or reduce an image. You can set 
any integer from 25 to 400(%) for the zoom ratio. This is not available when Booklet printing 
is enabled or any of the drawers is selected for “Paper Source”.

Available original paper sizes are listed below:

Letter
Ledger
Legal
Statement
Computer
13”LG
A4

A5
A3
B4
B5
Folio
8K
16K

Envelope COM10
Envelope Monarch
Envelope DL
Envelope Cho-3
Envelope You-4

1

2

3

4

5

6

7
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4) Paper Source
This selects the paper source. Please select a paper source that correlates with the printing 
size.
- Automatic — Automatically selects the paper set in this equipment according to the 

printed document size.
- Drawer1 — Paper is fed from the 1st Drawer.
- Drawer2 — Paper is fed from the 2nd Drawer (Paper Feed Unit (optional)). This cannot 

be selected if the Paper Feed Unit (optional) is not installed.
- Drawer3 — Paper is fed from the 3rd Drawer (the upper Drawer of Paper Feed Pedestal 

(optional)). This cannot be selected if the Paper Feed Pedestal (optional) is not installed.
- Drawer4 — Paper is fed from the 4th Drawer (the lower Drawer of Paper Feed Pedestal 

(optional)). This cannot be selected if the Paper Feed Pedestal (optional) is not installed.
- Bypass Tray — Paper is fed from the Bypass Tray. (When an envelope is selected in the 

“Original Paper Size” option, “Paper Source” is automatically set to this.)

The selectable values vary depending on the optional devices installed on this equipment 
and their configuration on the Configuration tab.

5) Paper Type
This sets the media type of the paper.
- Plain — Select this when printing on 20 lbs plain paper (64-80 g/m2 plain paper).
- Thick1 — Select this when printing on 24-28 lbs thick paper (81-105 g/m2 thick paper).
- Thick2 — Select this when printing on 32-90 lbs thick paper (106-163 g/m2 thick paper).
- Transparency — Select this when printing on transparent sheets.
- Envelope — When an envelope is selected in the “Print Paper Size” option, “Paper 

Type” is automatically set to this.

6) Number of Copies
This sets the number of printed copies. You can set any integer from 1 to 999.

If the data size of a print job exceeds the memory capacity of this equipment, more than one 
set of documents with a large number of pages or a large volume of graphics will not be 
printed in the correct set numbers. Only one set of the documents and an error report are 
printed out.

7) Orientation
This sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape — The document is printed in the landscape direction.
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— Finishing tab
The Finishing tab allows you to enable sort printing, 2-sided printing, and N-up printing.

1) Copy Handling
This sets how to sort the printed sheet when numerous copies are made for printing.
- Sort Copies — Select this for sort-printing (1, 2, 3... 1, 2, 3...).

- Group Copies — Select this for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...).

- Rotated Sort Copies — Select this for rotate sort-printing.

“Group Copies” and “Rotated Sort Copies” can be selected only when more than 2 cop-
ies are entered at the Number of Copies option.
“Rotated Sort Copies” can be selected only when “Letter”, “A4”, “B5”, or “16K” is selected 
at the Print Paper Size option.
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2) 2-Sided Printing
This sets 2-Sided printing (printing on both sides of paper) according to the type of binding 
for 2-sided-printed pages.
- None — Select this if you do not want to print on both sides of the paper.
- Book — Select this to print on both sides of the paper in the same direction and to bind 

the document along the vertical side of the paper so that the pages can be turned over 
right and left.

- Tablet — Select this to print on both sides of the paper with a vertical reversal and to bind 
the document along the horizontal side of the paper so that the pages can be turned over 
up and down.

- Booklet — Select this to print a properly paginated booklet or magazine-style publica-
tion. When this is selected, click [Details...] to specify the detail of the Booklet printing.

2-Sided printing cannot be set when the one of envelopes size in selected at the “Print 
Paper Size” drop down menu in the Basic tab.
2-Sided printing cannot be set when the following paper type in selected at the “Paper 
Type” drop down menu in the Basic tab.
- Thick 1
- Thick 2
- Transparency

When Booklet printing is performed using the PS3 printer driver from an application that 
can create the PS command directly, the overlay image will not be printed. In that case, 
disable the “Use PostScript Passthrough” option in the PostScript Settings dialog box.

 P.117 “PostScript settings”
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The Booklet Details dialog box appears when you click [Details] of Booklet printing.

Output Document Layout
Select the booklet size to be made.
- A5 on A4 — Select this to print a A5 size booklet. Every 2 pages are printed on A4 paper 

to fit on half a sheet (A5).
- A4 on A3 — Select this to print a A4 size booklet. Every 2 pages are printed on A3 paper 

to fit on half a sheet (A4).
- B5 on B4 — Select this to print a B5 size booklet. Every 2 pages are printed on B4 paper 

to fit on half a sheet (B5).
- Letter-Half on Letter — Select this to print a 1/2 Letter size booklet. Every 2 pages are 

printed on Letter paper to fit on half a sheet.
- LT on LD — Select this to print a Letter size booklet. Every 2 pages are printed on Led-

ger paper to fit on half a sheet (Letter).
- A6 on A5 — Select this to print a A6 size booklet. Every 2 pages are printed on A5 paper 

to fit on half a sheet (A6).
- B6 on B5 — Select this to print a B6 size booklet. Every 2 pages are printed on B5 paper 

to fit on half a sheet (B6).
- 1/2 LG on LG — Select this to print a 1/2 Legal size booklet. Every 2 pages are printed 

on Legal paper to fit on half a sheet.
- 1/2 Comp on Comp — Select this to print a 1/2 Computer size booklet. Every 2 pages 

are printed on Computer paper to fit on half a sheet.
- 1/2 Folio on Folio — Select this to print a 1/2 Folio size booklet. Every 2 pages are 

printed on Folio paper to fit on half a sheet.
- 1/2 Statement on Statement — Select this to print a 1/2 Statement size booklet. Every 2 

pages are printed on Statement paper to fit on half a sheet.
- 1/2 13’LG on 13’LG — Select this to print a 1/2 13inchLG size booklet. Every 2 pages 

are printed on 13inchLG paper to fit on half a sheet.
- 32K on 16K — Select this to print a 32K size booklet. Every 2 pages are printed on 16K 

paper to fit on half a sheet.
- 16K on 8K — Select this to print a 16K size booklet. Every 2 pages are printed on 8K 

paper to fit on half a sheet.

Page Order - From Left to Right
Select this to print the pages from left to right.

Page Order - From Right to Left
Select this to print the pages from right to left.
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Margin - Center
This sets the gutter on the center of two sided page. You can enter up to 0.500 inch (12.700 
mm). The printed images will be reduced according to the margin setting.

Margin - Outer
This sets the gutter on the right side and left side on the paper. You can enter up to 1.00 inch 
(25.40 mm). The printed images will be reduced according to the margin setting.

Margin - Units
Select the unit for the Center Margin and Outer Margin option. The default unit varies 
depending on the regional setting in the Windows.

3) Number of pages per sheet
This sets the printing of multiple pages on one sheet. The pages are reduced to fit the 
selected paper size automatically and printed.
- 2 pages — Select this to print images from 2 pages arranged on one sheet.
- 4 pages — Select this to print images from 4 pages arranged on one sheet.
- 6 pages — Select this to print images from 6 pages arranged on one sheet.
- 8 pages — Select this to print images from 8 pages arranged on one sheet.
- 9 pages — Select this to print images from 9 pages arranged on one sheet.
- 16 pages — Select this to print images from 16 pages arranged on one sheet.

Direction of print
This sets how the pages are arranged on one sheet.
- Left to Right — Select this to arrange pages horizontally from the left and printed top to 

bottom on one sheet.
- Right to Left — Select this to arranged pages horizontally from the right and printed top 

to bottom on one sheet.
- Left to Right by column — Select this to arrange pages vertically from the top and 

printed left to right on one sheet.
- Right to Left by column — Select this to arrange pages vertically from the top and 

printed right to left on one sheet.

Draw Borders Around Pages
Check this to print borders around each page.

N in 1 printing is not available when Booklet printing is selected in “2-Sided Printing”.
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— Paper Handling tab
The Paper Handling tab contains Cover page printing.

1) Destination
“Inner Tray” is set by default. (Unselectable)

2) Use Front Cover
This sets front cover printing which allows you to insert or print a cover on a sheet fed from a 
different tray than the Paper Source option selected on the Setup tab.
To enable cover printing, check on the box and select the location from where a cover sheet 
is to be fed and the print style to be used.

Source
Select the location from where a cover sheet is to be fed. When “Automatic” is selected, the 
paper is automatically selected according to the printed document size.

Selectable paper sources vary depending on the optional devices installed in this equip-
ment and configuration of the print options on each tab.
When you feed paper from the Bypass Tray, press the [START] button. To cancel print-
ing, press the [CLEAR/STOP] button.

Print Style
This selects how you want to print a cover.
- Do not print on page — Select this to insert a blank cover.
- Print on 1 side of page — Select this to print the first page image on the front side of a 

cover.
- Print on both sides of page — Select this to print the first two page images on both 

sides of a cover. This is available only when the 2-Sided Printing option is enabled on the 
Finishing tab.

If “Print on 1 side of page” is selected while 2-Sided Printing is performed, the first page is 
printed on the front side of the cover sheet and the back side of the cover will be blank.
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3) Use Back Cover
This sets back cover printing which allows you to insert or print a back cover on a sheet fed 
from a different tray than the Paper Source option selected on the Setup tab.
To enable back cover printing, check on the box and select the location from where a back 
cover sheet is to be fed and the print style to be used.

Source
Select the location from where a back cover sheet is to be fed. When “Automatic” is selected, 
the paper is automatically selected according to the printed document size.

Selectable paper sources vary depending on the optional devices installed in this equipment 
and configuration of the print options on each tab.

Print Style
This selects how you want to print a back cover.
- Do not print on page — Select this to insert a blank cover.
- Print on 1 side of page — Select this to print the last page image on the front side of a 

cover.
- Print on both sides of page — Select this to print the last two page images on both 

sides of a cover. This is available only when the 2-Sided Printing option is enabled on the 
Finishing tab.

If “Print on 1 side of page” is selected while 2-Sided Printing is performed, the last page is 
printed on the front side of the cover sheet and back side of the cover will be blank.
If “Print on both sides of page” is selected but there is only one page printed on the back 
cover, the last page is printed on the front side of the cover sheet and back side of the 
cover will be blank.
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— Image Quality tab
The Image Quality Tab allows you to select how images are printed. You can easily select appro-
priate image quality depending on the type of a document.

1) Halftone
This sets how halftone are printed.
- Auto — Select this to print automatically using proper halftone depending on the con-

tents in the document. When this is selected, halftone is printed in detail for text, and 
smoothly for graphics.

- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

“Auto” can be selected only for the PS3 printer driver.

2) Smoothing
Check this to print the texts and graphics smoothly.

3) Distinguish Thin Lines
Check this to print thin lines clearly.

4) Use Black for All Text
Check this to print all texts in 100% black except white texts.
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— Effect tab
The Effect tab contains print options that add the effects to your print jobs such as Watermarks, 
Overlay Image printing, and so on.

Effect tab for PCL6

Effect tab for PS3

1) Watermark
This selects the watermark to be used or edited. The following values except “None” are the 
default watermarks that have been registered in the printer driver. New watermarks you cre-
ate are added to the drop down box list.
- None — Select this if no watermark is desired.

The following default watermarks are also displayed in the drop down box:
- TOP SECRET
- CONFIDENTIAL
- DRAFT
- ORIGINAL
- COPY
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[Add]
Click this to create new watermark. The Watermark dialog box appears by clicking on this.

 P.114 “Add/Edit watermark”

[Edit]
Select a watermark from the Watermark drop down box and click it to edit the watermark. 
The Watermark dialog box appears by clicking on this.

 P.114 “Add/Edit watermark”

[Delete]
Select a watermark from the Watermark drop down box and click it to edit a watermark.

The default watermarks can be deleted but, If deleted, they cannot be restored.
“None” cannot be deleted.

Print on First Page Only
Check this to print a watermark on the first page only. This setting will become available 
when any watermark is selected from the Watermark drop down box.

2) Overlay Image
This selects an overlay image to be used. This feature allows you to print an image on the 
background of a print job, although the watermark allows only a text.

If the print job has several pages in the document, only the first page of the document will 
be saved as an overlay file.
Both the overlay file and the documents on which you superimpose the overlay image 
must be created at the same size, orientation, and resolution.
When printing with Overlay Image using the PS3 printer driver from an application that 
can create the PS command directly, the overlay image will not be printed. In that case, 
disable the “Use PostScript Passthrough” option in the PostScript Settings dialog box.

 P.117 “PostScript settings”

If you want to use an overlay image in your job, you must first create an overlay file. To cre-
ate an overlay image, create an overlay image with most applications and print it as an over-
lay file. You can enable creating an overlay file on the Print Job Tab.

 P.121 “Creating an overlay file”

[Delete]
Click this to delete the overlay image that you select in the drop down box.

Print over the document
Check this to print overlay image over the document.

3) Rotate 180 degrees
Check on this to perform rotation printing of an image.

4) Mirror
Check on this to perform mirror printing of an image. This print option is available only for the 
PS3 printer driver.
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The mirror printing may not be applied when the application gives priority to the applica-
tion’s PostScript settings over the printer driver settings.
When printing from Adobe Acrobat or such applications, the mirror printing does not work 
if the “Use PostScript Passthrough” option is enabled in the PostScript settings. To use 
the mirror printing, please disable the “Use PostScript Passthrough” option in the Post-
Script settings.

5) Negative/Positive
Check on this to perform negative printing of an image. This print option is available only for 
the PS3 printer driver.

The negative printing may not be applied when the application gives priority to the appli-
cation’s PostScript settings over the printer driver settings.
When printing from Adobe Acrobat or such applications, the Negative/Positive printing 
does not work if the “Use PostScript Passthrough” option is enabled in the PostScript set-
tings. To use the Negative/Positive printing, please disable the “Use PostScript 
Passthrough” option in the PostScript settings.

Add/Edit watermark
When you click [Add] or [Edit], the Watermark dialog box appears and you can create new 
watermark or edit selected watermarks.

1) X Position
The horizontal position of a watermark is displayed. You can change the position using the 
horizontal scroll bar.

2) Y Position
The vertical position of a watermark is displayed. You can change the position using the ver-
tical scroll bar.

3) Units
Select the unit for the “X Position” and “Y Position” field.

4) [Center Watermark]
Click this to automatically move the watermark position to the center.
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5) Caption
Enter the text of a watermark. You can enter up to 63 alphanumeric characters. When you 
are editing a watermark, the selected watermark text is displayed in the field.

6) Font Name
Select the font to be used for the watermark text.

7) Style
Select the font style for the watermark text.
- Regular — Select this to set the regular style to the text.
- Bold — Select this to set the bold style to the text.
- Italic — Select this to set the italic style to the text.
- Bold Italic — Select this to set the bold and italic style to the text.

8) Font Size
Enter the font size for the watermark text. The font size can be set from 6 to 300 pt in units of 
1 pt.

9) Angle
Enter the degree of angle for rotating the watermark text. The angle can be set from -90 to 
90 degrees in units of 1 degree. You can also set the degree of angle by moving the scroll 
bar.

10)Solid
Select this to print solid type of watermark.

11) Draw as Outline
Select this to print outline type of watermark.

12)Transparency
Select this to print a transparent watermark. When you select this, set the brightness from 0 
(darker) to 100% (lighter) in units of 1%. You can also set the brightness using the scroll bar.
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— Others tab
The Others tab contains print options such as toner saving, custom paper size and so on.

Others Tab for PCL6

Others Tab for PS3

1) Default Menu Setting
Select the default tab that is displayed when opening the properties of printer driver.

2)  Toner Save
Check this to print in toner save mode.

When the toner save mode is enabled, printing may become light.

3) Do not Print Blank Pages
Check this ignore blank pages for printing.
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If Watermark feature is enabled all pages will be printed even when the content is blank.
The pages that the header or footer exists will be printed even if the content are blank.

4) [PostScript Settings]
Click this to specify the PostScript specific functions. The PostScript Settings dialog box 
appears by clicking this. This print option is available only for the PS3 printer driver.

 P.117 “PostScript settings”

5) Department
Enter the user’s department code if the system is managed with department codes. Please 
ask your administrator for your department code.

If printing is performed with an incorrect department code, a dialog box indicating that it is 
incorrect appears. In this case, enter the correct one or stop transmitting. If this dialog box 
does not appear, the job becomes invalid and is deleted. An error report is then printed out 
from this equipment. (If the “Enable SNMP Communication” check box of the Configuration 
tab menu of the printer is checked, an error message appears before the job is deleted.

PostScript settings

1) Output Format
This selects the output format for printing.
- ASCII — The job is sent in the ASCII data format.
- Encapsulated PostScript (EPS) — The job is sent in the EPS format.
- Tagged BCP — Select this to send a job in Tagged Binary format over parallel ports.
- Using Adobe DSC — Select this to send a job with the DSC comments.

The EPS format is usually used for creating an image to import into another document. 
Therefore, only the first page of the document will be printed when “Encapsulated PostScript 
(EPS)” is selected.

2) Print Error Information
Check on this to print a PS error information page when any errors occur for printing.

3) Compress Bitmap
Check on this to send compress bitmaps to this equipment.

4) Use PostScript Passthrough
Check this for PostScript data created by the application to be passed through to this equip-
ment.
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If this option is enabled, the following print options may not work correctly when printing from 
the application that creates the PostScript code for printing such as Adobe Acrobat. In that 
case, please disable this option for printing.
- Manual Scale
- Print Paper Size
- Paper Type
- User Front Cover
- User Back Cover
- Booklet
- Multiple Pages per Sheet
- All options in the Effect tab
- All options in the Image Quality tab

— Fonts tab
The Fonts tab allows you to select how the TrueType fonts are printed. The following figure is the 
Fonts Tab for the PS3 printer driver.

The Fonts tab can be displayed only from theDevices and Printers folder (and not displayed 
when displaying the properties from the application’s Print dialog box).

For Windows 7, some tab menus have a  button in the printer driver properties. To 
change the properties, click on it. If the properties cannot be changed, ask your system 
administrator.

1) TrueType Options
This sets how to print TrueType fonts.
- Always Use TrueType Fonts — Select this to print the document the same as the print 

image shown on the screen. All TrueType fonts are extracted on the system for printing.
- Always Use Printer Fonts — Select this to substitute the TrueType fonts with the inter-

nal fonts for printing. The print result may differ from the print image on the screen.
- Use Font Substitution Table — Select this to substitute the TrueType fonts using the 

internal fonts according to the settings of the font substitution table. You can edit the font 
substitution table that is displayed at the Substitution Table Edit table.
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- Download as Bitmap — Select this to print the document as same as the image shown 
on the screen.

The default value will be “Always Use TrueType Fonts” for the PCL6 printer driver.
The default value will be “Use Font Substitution Table” for the PS3 printer driver.

2) Substitution Table Edit
This table shows how each TrueType font is substituted. You can edit the substitution setting 
for each TrueType font. In this table, the TrueType font names are displayed in the TrueType 
Font column, and how the TrueType font is printed is shown in the Use Printer Font column.
To edit the substitution table, select the TrueType font that you want to edit from the table, 
and select how the TrueType font is printed at the Printer Font For drop down box.
At the Printer Font For drop down box, you can select “Download as Soft Font” to send the 
TrueType fonts in Type 42 format, or other available printer fonts to be substituted. The 
printer fonts displayed in the drop down box differ depending on the TrueType fonts.

— Configuration tab
The Configuration Tab allows you to configure options. When any optional unit is installed in this 
equipment, set the configuration of the machine on this tab.

The Configuration tab can be displayed only from the Devices and Printers folder (and not 
displayed when displaying the properties from the application’s Print dialog box).

For Windows 7, some tab menus have a  button in the printer driver properties. To 
change the properties, click on it. If the properties cannot be changed, ask your system 
administrator.

1) Model Selection
Select the model name of this equipment.

2) Automatic Duplexing Unit
Check this when the Automatic Duplexing Unit (optional) is installed.
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3) Drawers
Select the current drawer configuration.
- Drawer 1 – Select this when only the Drawer 1 is installed and any optional drawers are 

not installed.
- Drawer 1 & Drawer 2 – Select this when the Drawer 2 (optional) is installed as well as 

the Drawer 1.
- Drawer 1, 2 & Drawer 3 – Select this when the Drawers 2 and 3 are installed as well as 

the Drawer 1.
- Drawer1, 2 & Drawer 3, 4 – Select this when the Drawers 2, 3 and 4 are installed as well 

as the Drawer 1.

4) Enable SNMP Communication
Check this to enable obtaining the configuration information from this equipment.
- Update Automatically: Select this when option configuration information needs to be 

updated automatically.
- Manual: Select this when option configuration information needs to be updated manually. 

Click [Update Now] to update the information.

5) [Drawer Settings]
Click this to set the paper size and paper type of each drawer. The Drawer Settings dialog 
box appears by clicking this.

Paper Size
Select the paper size set in each drawer.

Paper Type
Select the paper type set in each drawer. The paper types for the 1st drawer to 4th drawer 
are fixed to “Plain”.

6) [Version Information]
Click this to display the Version Information dialog box.
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Printing with extended print functionality
In this section, procedures are given to print various types of print job, using the layout and fin-
ishing options. This section can help you to find a print method that you desired.

Printing various print job types
The printer drivers provide the way to handle an overlay image file in addition to normal printing.

— Creating an overlay file
You can print a document as an overlay file. The created overlay file can then be merged into 
another document during printing.

 P.132 “Printing with an Overlay File”

If the print job has several pages in the document, only the first page of the document will be 
saved as an overlay file.
Both the overlay file and the documents on which you superimpose the overlay image must 
be created at the same size and orientation.
When creating an overlay file using the PS3 printer driver from an application that can create 
the PS command directly, the overlay file will not be created properly. In that case, disable 
the “Use PostScript Passthrough” option in the PostScript Settings dialog box.

 P.117 “PostScript settings”

Printing a document as an overlay file

1 Select “Print to Overlay File” in the “Print Job” drop down menu.

2 Click […] on the right side of the drop down menu.
The Overlay Image Name dialog box appears.

3 Enter a overlay image name and then click [OK].

You can enter up to 63 characters.

4 Set any other print options you require and click [OK].

5 Click [OK] or [Print] to send a print job.
The document is saved as an overly file.

You can use created overly file to print a document.
 P.132 “Printing with an Overlay File”
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Printing with various layout and finishing options
Printer drivers allows you to create a print job with layout options to make your document more 
essential. Also you can enable finishing options that determine how the jobs are output, such as 
sorting and creating a booklet.

— Sort printing
You can select how multiple copies of a document to be output, such as separately for each 
copy, grouping each page, and alternating the paper direction for each copies.

Output each copy separately

1 Display the Basic tab and enter the number of copies to be printed 
at the “Number of Copies” field.

2 Display the Finishing tab and select “Sort Copies” icon at “Copy 
Handling”.

3 Set other print options you require and click [OK].

4 Click [OK] or [Print] to send a print job.
The print job is output separately for each copy.
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Output with grouping of each page within a set

For example, assume that you have a three page job (A, B, C) and you want three copies of 
each page in this order (AAA, BBB, CCC).

1 Display the Basic tab and enter the number of copies to be printed 
at the “Number of Copies” field.

2 Display the Finishing tab and select “Group Copies” icon at “Copy 
Handling”.

3 Set other print options you require and click [OK].

4 Click [OK] or [Print] to send a print job.
The print job is output separately for each page.

Output in a different direction for each copy

Rotated Sort Copies can be enabled only when printing on Letter, A4, B5 or 16K.

1 Display the Basic tab and enter the number of copies to be printed 
at the “Number of Copies” field.

2 Display the Finishing tab and select “Rotated Sort” icon at “Copy 
Handling”.

3 Set other print options you require and click [OK].

4 Click [OK] or [Print] to send a print job.
The print job is output in different direction for each copy.
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— Enlarge/Reduce Printing
You can automatically enlarge or reduce a document image to fit a specified paper size, or man-
ually set the zoom ratio to enlarge or reduce the image.

Printing enlarged or reduced image to fit specified paper size

1 Display the Basic tab and select the document size on the “Original 
Paper Size” drop down box. Then select the paper size that you 
want to print at the “Print Paper Size” drop down box.

The document image is automatically enlarged or reduced depending on the original 
paper size and print paper size.

2 Set other print options you require and click [OK].

3 Click [OK] or [Print] to send a print job.
Enlarged or reduced image is printed to fit specified paper size.

Printing an enlarged or reduced image by specifying the zoom ratio manually

1 Display the Basic tab and check the “Manual Scale” box. Then 
enter the percentage of zoom ratio.

The zoom ratio can be set from 25% to 400% in units of 1%.

2 Set other print options you require and click [OK].

3 Click [OK] or [Print] to send a print job.
Enlarged or reduced image is printed by specified zoom ratio.
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— Printing on Both Sides of a Sheet
You can print on both sides of the paper.

Printing both sides of paper

1 Display the Finishing tab, check the “2-Sided Printing” check box 
and select the direction to be printed.

Book — Select this to print on both sides of the paper in a vertically direction, so the 
pages can be bound and turned over right and left.
Tablet — Select this to print on both sides of the paper in a vertical reversal motion, so 
the pages can be bound and turned over up and down.

2 Set other print options you require and click [OK].

3 Click [OK] or [Print] to send a print job.
The print job is printed on both side of paper in the specified direction.

— Printing front covers or back covers from different paper sources
You can print paper for front covers or back covers by feeding from different paper source. 

Printing or inserting a front cover and back cover

1 Display the Paper Handling tab.

2 To print or insert a front cover, check the “Use Front Cover” box 
and select the drawer where the cover paper is loaded at the 
“Source” drop down menu. Then select whether inserting a blank 
cover or printed front cover at the “Print Style” drop down menu. 

Do not print on page — Select this to insert a blank cover.
Print on 1 side of page — Select this to print the first page image on the front side of a 
cover.
Print on both sides of page — Select this to print the first two page images on both 
sides of a cover. 

When “Automatic” is selected in the “Source” drop down box, the paper is automati-
cally selected according to the printed document size.
“Print on both sides of page” is available only when 2-Sided printing is enabled at the 
Setup tab.
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3 To print or insert a back cover, check the “Use Back Cover” box 
and set the “Source” and “Print Style” options that you require.

How to set the Source and Print Style options are the same as “Use Front Cover” option.

4 Set other print options you require and click [OK].

5 Click [OK] or [Print] to send a print job.
A front cover and back cover are printed or inserted for output.

— Printing booklets
Printing in normal booklet mode produces a document that, when folded, becomes a properly 
paginated booklet or magazine-style publication.
For example, if you create a document on letter-size paper (8½ x 11 inches) and then print in 
booklet mode, the yield is a 5½-x-8½-inch booklet. Each page has been scaled to fit on half a 
sheet and reordered so that the booklet is properly paginated when folded.
To retain your original document size when printing booklets, select the booklet size same as 
your original document size. Then, your 8½-inch document is printed on ledger size paper (11 x 
17 inches) and reordered so that, when folded, the yield is an 8½-x-11-inch booklet. You can 
select from the following page-size options when printing a tiled booklet:

Letter Booklet on Ledger
A4 Booklet on A3
B5 Booklet on B4

When Booklet printing is performed using the PS3 printer driver from an application that can cre-
ate the PS command directly, the overlay image will not be printed. In that case, disable the “Use 
PostScript Passthrough” option in the PostScript Settings dialog box.

 P.117 “PostScript settings”

You can create a booklet by folding printed paper along the center by yourself.

Creating a booklet

1 Display the Finishing tab.

2 Check the “2-Sided Printing” box and select the “Booklet” icon.

3 Click [Details...].
The Booklet Details dialog box appears.
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4 Select the a booklet size at the “Output Document Layout” drop 
down menu.

A5 on A4 — Select this to print a A5 size booklet. Every 2 pages are printed on A4 paper 
to fit on half a sheet (A5).
A4 on A3 — Select this to print a A4 size booklet. Every 2 pages are printed on A3 paper 
to fit on half a sheet (A4).
B5 on B4 — Select this to print a B5 size booklet. Every 2 pages are printed on B4 paper 
to fit on half a sheet (B5).
B6 on B5 — Select this to print a B6 size booklet. Every 2 pages are printed on B5 paper 
to fit on half a sheet (B6).
1/2 Folio on Folio — Select this to print a 1/2 Folio size booklet. Every 2 pages are 
printed on Folio paper to fit on half a sheet.
A6 on A5 — Select this to print a A6 size booklet. Every 2 pages are printed on A5 paper 
to fit on half a sheet (A6).
Letter-Half on Letter — Select this to print a 1/2 Letter size booklet. Every 2 pages are 
printed on Letter paper to fit on half a sheet.
LT on LD — Select this to print a Letter size booklet. Every 2 pages are printed on 
Ledger paper to fit on half a sheet (Letter).
1/2 LG on LG — Select this to print a 1/2 Legal size booklet. Every 2 pages are printed 
on Legal paper to fit on half a sheet.
1/2 Statement on Statement — Select this to print a 1/2 Statement size booklet. Every 2 
pages are printed on Statement paper to fit on half a sheet.
1/2 Comp on Comp — Select this to print a 1/2 Computer size booklet. Every 2 pages 
are printed on Computer paper to fit on half a sheet.
1/2 13LG on 13LG — Select this to print a 1/2 13inchLG size booklet. Every 2 pages are 
printed on 13inchLG paper to fit on half a sheet.
32K on 16K — Select this to print a 32K size booklet. Every 2 pages are printed on 16K 
paper to fit on half a sheet.
16K on 8K — Select this to print a 16K size booklet. Every 2 pages are printed on 8K 
paper to fit on half a sheet.

5 Select the page order for booklet in the “Page Order” option.

From Left to Right — Select this to print the pages from left to right.
From Right to Left — Select this to print the pages from right to left.
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6 If you want to add a margin space between facing pages, enter a 
width in the “Center” field, and if you want to add a margin on the 
outside edge, enter a width in the “Outer” field.

You can change the unit of the margin at the “Units”.

7 Set any other print options you require and click [OK].

8 Click [OK] or [Print] to send the print job.
The print job is printed as a booklet.

— Printing several reduced pages per sheet
The N-up feature allows you to condense and print several pages of a document on one sheet of 
paper. This feature is very useful for browsing a large number of pages for appearance or page 
order.
For example, to check the navigation path of a number of web pages or review the narrative of a 
slide presentation, using N-up is not only convenient but conserves paper as well.

If you are using the Image Overlay feature in combination with N-up printing, the overlay prints 
once per sheet, rather than once per page.

Printing multiple pages per sheet

1 Display the Finishing tab.

2 Select how many pages you want to print on a single sheet at the 
“Number of pages per sheet” check box.

2 pages — Select this to print images from 2 pages arranged on one sheet.
4 pages — Select this to print images from 4 pages arranged on one sheet.
6 pages — Select this to print images from 6 pages arranged on one sheet.
8 pages — Select this to print images from 8 pages arranged on one sheet.
9 pages — Select this to print images from 9 pages arranged on one sheet.
16 pages — Select this to print images from 16 pages arranged on one sheet.
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3 Select how the pages are arranged on one sheet in the “Direction of 
print” option.

Left to Right — Select this to arrange pages horizontally from the left and printed top to 
bottom on one sheet.
Right to Left — Select this to arranged pages horizontally from the right and printed top 
to bottom on one sheet.
Left to Right by column — Select this to arrange pages vertically from the top and 
printed left to right on one sheet.
Right to Left by column — Select this to arrange pages vertically from the top and 
printed right to left on one sheet.

4 If you want to draw a line around each page, check the “Draw Bor-
ders Around Pages” box.

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
Multiple pages are printed per sheet.

— Using watermarks
Watermarks overprint your document with useful information, such as “Confidential,” “Draft,” or 
“Original.” You can choose from several predefined watermarks or you can create and save your 
own custom watermarks.

A watermark cannot be used for an overlay file. If “Print to Overlay File” is selected in Print Job 
tab, the watermark setting items are grayed and cannot be set. 

Watermarks are text only. To add graphics or other document elements, use image overlays 
instead.

 P.132 “Printing with an Overlay File”

Printing a watermark

1 Display the Effect tab and select the watermark to be printed at the 
“Watermark” drop down box.

You can create a new watermark if the watermark that you prefer is not listed in the drop 
down menu.



3 PRINTING <GA-1191>

130    Printing from Windows

2 If you want to print the watermark on only the first page, check on 
the “Print on First Page Only” box.

3 Set other print options you require and click [OK].

4 Click [OK] or [Print] to send a print job.
The print job is printed with the watermark.

Creating or editing a watermark

1 Click [Add] to create new watermark, or select a watermark that you 
want to edit and click [Edit] to edit a watermark.

The Watermark dialog box appears.

2 Enter the watermark text in the “Caption” field.
You can enter up to 63 characters for the “Caption” field.

3 Select a font for the watermark at the “Font Name” drop down box.

4 Select a font style for the watermark at the “Style” drop down box.

5 Enter the font size in the “Font Size” field.
You can enter any integer between 6 to 300pt in units of 1pt.

6 To rotate the watermark, enter the degrees in the “Angle” field.
You can enter from -90 degrees to 90 degrees in units of 1 degree in the “Angle” field.
You can also set the angle using the scroll bar.
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7 Select how the watermark text is printed from “Solid”, “Draw as 
Outline”, and “Transparency”.
Solid — Select this to print solid type of watermark.
Draw as Outline — Select this to print an outline type of watermark.
Transparency — Select this for a transparent watermark. Set the transparent ratio from 
0 to 100% in units of 1%. You can also set the transparent ratio using the scroll bar.

8 Click [OK] to save the watermark settings.
The watermark is added or edited.

Deleting a watermark

You can delete the default watermarks. However, they cannot be restored by clicking the 
[Restore Defaults] button.

1 Select a watermark that you want to delete at the “Watermark” drop 
down box.

2 Click [Delete].
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— Printing with an Overlay File
Using image overlays ensures that widely-used images are readily available and consistently 
reproduced. Image overlays are independent documents that are merged into other documents 
during printing and thereby increase the time required to print a job. To superimpose text on your 
document, it may be faster to use watermarks.
To print with an overlay file, you should create an overlay file first.

 P.121 “Creating an overlay file”

If you use Image Overlays in combination with the N-up feature, the image overlay is printed 
once per sheet, not once per page.
Both the overlay file and the documents on which you superimpose the overlay image must 
be created at the same size and orientation.
When creating an overlay file using the PS3 printer driver from an application that can create 
the PS command directly, the overlay file will not be created properly. In that case, disable 
the “Use PostScript Passthrough” option in the PostScript Settings dialog box.

 P.117 “PostScript settings”

Printing an overlay image on a print job

1 Display the Effect tab and select the overlay image name to be used 
in the “Overlay Image” drop down box.

2 Set other print options you require and click [OK].

3 Click [OK] or [Print] to send a print job.
The print job is printed with the overlay image.

Deleting an overlay file

1 Select the overlay file that you want to delete at the “Overlay 
Image” drop down box.

2 Click [Delete].
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Printing from Macintosh

This equipment supports printing from Macintosh applications.

Printing from application on Mac OS X 10.2.4 to Mac OS X 10.6.x
Once you have installed the PPD file as described in  P.57 “Installing the printer on Mac OS X 
10.2.4 to Mac OS X 10.6.x”, you can print directly from most Mac OS applications.

If you print a PDF file with “Preview” application on Mac OS 10.2.x, the page order will be incor-
rect. Please use Adobe Acrobat Reader.

How to print from Mac OS X 10.2.4 to Mac OS X 10.6.x
All writers are managed within the Print Center utility and there is no need to switch the printer.
Once you add a printer to the Printer List, all printers can be selected directly from Print Setup 
dialog box.

— Setting options and printing from Macintosh computers
In Mac OS applications, print options are set from both the Page Setup dialog box and the Print 
dialog box.

Printing from Macintosh applications

1 Open a file and select [Page Setup] from the [File] menu of the 
application.

2 Select the name of the equipment at the “Format for” drop down 
box and specify the Page Setup settings for your print job.

Setting the Page Setup varies depending on how you want to print a document.
 P.135 “Print options for page setup dialog on Mac OS X 10.2.4 to Mac OS X 10.6.x”

3 Click [OK] to save the Page Setup settings.

4 Select [Print] from the [File] menu of the application.
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5 In the dialog box that appears, make sure the name of the equip-
ment is selected at the “Printer” menu and specify the Print set-
tings for your print job.

Setting the Print Setup varies depending on how you want to print a document.
 P.136 “Print dialog on Mac OS X 10.3.x to Mac OS X 10.6.x”
 P.149 “Print dialog on Mac OS X 10.2.4 to Mac OS X 10.2.8”

6 Click [Print] to print a document.

When the department management is enabled, if printing is performed with an incor-
rect department code, a dialog box indicating that it is incorrect appears. In this case, 
enter the correct one or stop transmitting. If this dialog box does not appear, the job 
becomes invalid and is deleted. An error report is then printed out from this equip-
ment.
If the data size of a print job exceeds the memory capacity of this equipment, more 
than one set of documents with a large number of pages or a large volume of graph-
ics will not be printed in the correct set numbers. Only one set of the documents and 
an error report are printed out.
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Print options for page setup dialog on Mac OS X 10.2.4 to Mac 
OS X 10.6.x
The Page Setup dialog boxes can be displayed by selecting the [Page Setup] command from 
the [File] menu of the application.
In the Page Setup dialog boxes, you can specify the Page Attribute settings.

The Page Setup dialog boxes vary across applications.

— Page Attributes

1) Format for
This select the printer to be used for printing.

2) Paper Size
This selects the size of a document to be printed.

3) Orientation
This sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape (90 degree) — The document is printed in the landscape direction from left.
- Landscape (270 degree) — The document is printed in the landscape direction from 

right.

4) Scale
This changes the size of the printed image on the page. Enter the zoom ratio to enlarge or 
reduce an image. You can set any integer from 25 to 400(%) for the zoom ratio.

Available original paper sizes are listed below:

US Letter
Tabloid (Ledger)
US Legal
Statement
Computer
13”LG

A4
A5
A3
JB4
JB5
Folio

8K
16K

2

1

3

4
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Print dialog on Mac OS X 10.3.x to Mac OS X 10.6.x
The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu 
of the application.

The [Print] dialog boxes are different between Mac OS X 10.2.4 to Mac OS X 10.2.8 and Mac 
OS X 10.3.x to Mac OS X 10.6.x. See the following section for the descriptions of the [Print] dia-
log boxes for Mac OS X 10.2.x to Mac OS X 10.2.8.

 P.149 “Print dialog on Mac OS X 10.2.4 to Mac OS X 10.2.8”

The [Page Setup] dialog boxes vary depending on applications. In some applications, it is not 
included in the [File] menu, but in the [Print] dialog box.

— Copies & Pages
In the Copies & Pages menu, you can set general print options such as the number of copies, 
and sort printing.
The following screenshot is the Copies & Pages menu accessed from Microsoft Word.

1) Preview window
The print preview is displayed.

2) Show Quick Preview
Select this check box to enable the preview feature.

3) [Page Setup]
Click this button to display the [Page Setup] dialog box.

4) Copies
This option sets the number of printed copies.

5) Collated
Select this check box for sort-printing (1, 2, 3... 1, 2, 3...).

6) Pages
This option sets the range of pages to be printed.

3

2

1

4

5

6
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- All — Select this option to print all pages.
- Current page — Select this option to print the page currently selected.
- Selection — Select this option to print only texts and objects selected on the page.
- From/to — Select this option to specify the pages to be printed. Enter the page range in 

the [From] and [to] boxes.
- Page range — Select this option to specify individual pages and/or page ranges to be 

printed. Enter page numbers and/or page ranges in the box.

— Layout
In the Layout menu, you can set N-up printing (multiple pages per sheet).

Mac OS X 10.5.x

Mac OS X 10.6.x

1) Pages per Sheet
This option sets the number of multiple pages printed on one sheet. The pages are reduced 
to fit the selected paper size automatically and are printed.
- 1 — Select this option if you do not wish to enable N-up printing.
- 2 — Select this option to print images from 2 pages arranged on one sheet.
- 4 — Select this option to print images from 4 pages arranged on one sheet.
- 6 — Select this option to print images from 6 pages arranged on one sheet.
- 9 — Select this option to print images from 9 pages arranged on one sheet.
- 16 — Select this option to print images from 16 pages arranged on one sheet.

1

2

3

4

5

5

6
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2) Layout Direction
This option sets how pages are arranged on one sheet. This option is available only when N-
up printing (printing multiple pages on one sheet) is enabled.

3) Border
Select this option if a border line is to be drawn on each page.
- None — Select this option if no border line is to be drawn.
- Single Hairline — Select this option to draw a single hairline for the border.
- Single Thin Line — Select this option to draw a single thin line for the border.
- Double Hairline — Select this option to draw a double hairline for the border.
- Double Thin Line — Select this option to draw a double thin line for the border.

4) Two-Sided
This option sets whether or not you want to print on both sides of the paper.
- Off — Select this option when you do not want to print on both sides of the paper.
- Long-edge binding — Select this option to bind along the long edge side of the paper. 

The direction to be printed on the back side of the paper differs depending on the orienta-
tion.

- Short-edge binding — Select this option to bind along the short edge side of the paper. 
The direction to be printed on the back side of the paper differs depending on the orienta-
tion.

5) Reverse page orientation
Select this check box to reverse page orientation.

6) Flip horizontally
Select this check box to flip a page horizontally.

Across Left to Right Before Down — Pages arranged horizontally from left to 
right and then top to bottom on one sheet.

Across Right to Left Before Down — Pages arranged horizontally from right to 
left and then top to bottom on one sheet.

Down Before Across Left to Right — Pages arranged vertically from top to bot-
tom and then left to right on one sheet.

Down Before Across Right to Left — Pages arranged vertically from top to bot-
tom and then right to left on one sheet.

1

2

Landscape
1 2

Portrait

1 2

Landscape
1

2

Portrait
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— Output Options
In the Output Options menu, you can save a print job as a file.

This menu is displayed only for Mac OS X 10.3.x.

1) Save as File
Select this check box to save a print job as a file. When this box is selected, select the file 
type in the [Format] box.

2) Format
This option sets the format of a file to be saved.
- PDF — Select this option to save a print job as a PDF file.
- PostScript — Select this option to save a print job as a PS file.

— Scheduler
In the Scheduler menu, you can set when a print job will be sent to the equipment.

1) Print Document
This option sets when a print job will be sent to the equipment.
- Now — Select this option to send a print job now.
- At — Select this option to specify the time to send a print job. Set the time to send the 

print job. The print job will be held in the queue on Mac OS X until the specified time or 
until you resume the print job to be sent from the queue on Mac OS X.

- On Hold — Select this option to hold a print job in the queue on Mac OS X. When you 
select this, the print job will be held in the queue on Mac OS X until you resume the print 
job to be sent from the queue on Mac OS X.

2) Priority
Select the priority of a print job.

1 2

1

2
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— Paper Handling
In the Paper Handling menu, you can set Reverse page order printing and Odd or Even num-
bered page printing.
The screens in the Paper Handling menu vary between Mac OS X 10.3.x and Mac OS X 10.4.x.

Mac OS X 10.3.x

1) Reverse page order
Select this check box when you want to print a document beginning with the last page.

2) Print
Select whether all pages will be printed or only odd or even pages will be printed.

Mac OS X 10.4.x

1) Page Order
Select the page order for printing.

2) Print
Select whether to print all pages or only odd/even pages.

3) Destination Paper Size
Select the output paper size.
- Use documents paper size — Select this option to print on the same sized paper as the 

document size.

1

2

1

3

2
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- Scale to fit paper size — Select this option to perform enlarge/reduce printing. Select 
the output paper size in the box. If you do not want to enlarge the document images 
when a larger paper size is selected, select the [Scale down only] check box.

Mac OS X 10.5.x

1) Page To Print
Select whether all pages will be printed or only odd or even pages will be printed.

2) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears 
as the default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. 

When this is selected, select the output paper size in the box. If you do not want to 
enlarge the document images when a larger paper size is selected, select the [Scale 
down only] check box.

3) Page Order
Select the page order for printing.

Mac OS X 10.6.x

1

3

2
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3
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1) Page To Print
Select whether all pages will be printed or only odd or even pages will be printed.

2) Page Order
Select the page order for printing.

3) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears 
as the default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. 

When this is selected, select the output paper size in the box. If you do not want to 
enlarge the document images when a larger paper size is selected, select the [Scale 
down only] check box.

— ColorSync
The ColorSync menu that is specific to color printers is not available for this equipment.

This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x.
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— Color Matching
The Color Matching menu that is specific to color printers is not available for this equipment.

This menu is displayed only for Mac OS X 10.5.x to Mac OS X 10.6.x.

— Cover Page
In the Cover Page menu, you can set whether to send a print job with a banner page. The ban-
ner page includes information about job owner, job name, application name, date and time, and 
printer name.

1) Print Cover Page
You can set how to insert a banner page.
- None — Select this option to print without a banner page.
- Before document — Select this option to print a banner page before the document.
- After document — Select this option to print a banner page after the document.

2) Cover Page Type
Select the type of the cover page.

1

2

3
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3) Billing Info
Enter the billing information to have it appear on the banner page.

Due to Mac OS limitations, text input into the [Billing Info] box will only be displayed up to the 
length of the field.

— Error Handling
In the Error Handling menu, you can set how to report a PostScript error.

This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x.

1) PostScript Errors
This sets whether to print a PostScript error report.
- No special reporting — Select this option if you do not want to print PostScript error 

information.
- Print detailed report — Select this option to print PostScript error information.

2) Tray Switching
This option is not supported by this equipment.

1

2
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— Paper Feed
In the Paper Feed menu, you can set the paper source.

1) All pages from
Select this option when you want to use the same paper source for all pages. When this 
option is selected, select the paper source or paper type to be used in the box.

2) First page from
Select this option when you want to specify different paper sources for the first page and 
remaining pages. When this option is selected, select the paper source or paper type to be 
used for the first page in the box.

3) Remaining from
Select the paper source or paper type to be used for remaining pages in the box. This option 
can be selected only when you select the [First page from] option.

— Print Mode
In the Print Mode menu, you can set the way this equipment handles the print job. 

Mac OS X 10.3.x

1
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1) Department Code
The Department Code feature can be used for managing each job. For example, a system 
administrator can check how many sheets of copies a certain department has made.
Select whether a department code is required for printing. When this option is enabled, spec-
ify the 5-digit department code in the field next to the box.
Enabling the department code depends on whether this equipment is managed with depart-
ment codes or not. Ask your administrator for your department code.

When the department management is enabled, if printing is performed with an incorrect 
department code, a dialog box indicating that it is incorrect appears. In this case, enter the 
correct one or stop transmitting. If this dialog box does not appear, the job becomes invalid 
and is deleted. An error report is then printed out from this equipment.

2) Do not Print Blank Pages
Select whether to ignore blank pages for printing.

When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the 
blank pages will be printed.
Pages with header or footer will be printed even if the content is blank.

3) Distinguish Thin Lines
Select whether to print thin lines clearly.

Mac OS X 10.4.x to Mac OS X 10.6.x

1

2

3
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1) Department Code
The Department Code feature can be used for managing each job. For example, a system 
administrator can check how many sheets of copies a certain department has made.
Select whether a department code is required for printing. When this option is enabled, spec-
ify the 5-digit department code in the field next to the box.
Enabling the department code depends on whether this equipment is managed with depart-
ment codes or not. Ask your administrator for your department code.

When the department management is enabled, if printing is performed with an incorrect 
department code, a dialog box indicating that it is incorrect appears. In this case, enter the 
correct one or stop transmitting. If this dialog box does not appear, the job becomes invalid 
and is deleted. An error report is then printed out from this equipment.

2) Distinguish Thin Lines
Select whether to print thin lines clearly.

3) Do not Print Blank Pages
Select whether to ignore blank pages for printing.

When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the 
blank pages will be printed.
Pages with header or footer will be printed even if the content is blank.

— Printer Features
In the Printer Features menu, you can specify various image quality features.

Quality
In the Quality menu, you can specify various image quality features.

1) Halftone
This option sets how to print halftones.
- Auto — Select this option to print using proper halftone depending on the contents in the 

document automatically.

1
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- Detail — Select this option to print halftone in detail.
- Smooth — Select this option to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the Toner Save mode.

When the Toner Save mode is enabled, printing may become light.

— Supply Levels
The Supply Levels menu is not supported by this equipment.

— Summary
In the Summary menu, you can confirm the current settings for printing.
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Print dialog on Mac OS X 10.2.4 to Mac OS X 10.2.8
The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu 
of the application.

The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x to Mac 
OS X 10.6.x. See the following section for the descriptions of the [Print] dialog box for Mac OS X 
10.3.x to Mac OS X 10.6.x.

 P.136 “Print dialog on Mac OS X 10.3.x to Mac OS X 10.6.x”

The [Print] dialog box varies depending on applications.

— Copies & Pages
In the Copies & Pages menu, you can set the general print options such as number of copies 
and sort printing.

1) Copies
This option sets the number of printed copies.

2) Collated
Select this check box for sort-printing (1, 2, 3... 1, 2, 3...).

3) Pages
This option sets the pages to be printed.
- All — Select this option to print all pages.
- From/to — Select this option to specify the pages to be printed. Enter the page range in 

the [From] and [to] boxes.

1 2

3
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— Layout
In the Layout menu, you can set N-up printing (multiple pages per sheets). The items in the Lay-
out menu vary depending on the Mac OS X version.

1) Pages per Sheet
This option sets the number of multiple pages to be printed on one sheet. The pages are 
reduced to fit the selected paper size automatically and are printed.
- 1 — Select this option if you do not wish to perform N-up printing.
- 2 — Select this option to print images from 2 pages arranged on one sheet.
- 4 — Select this option to print images from 4 pages arranged on one sheet.
- 6 — Select this option to print images from 6 pages arranged on one sheet.
- 9 — Select this option to print images from 9 pages arranged on one sheet.
- 16 — Select this option to print images from 16 pages arranged on one sheet.

2) Layout Direction
This option sets how pages are arranged on one sheet. This option is available only when N-
up printing (printing multiple sheets on a page) is enabled.

3) Border
Select if a border line is to be drawn on each page.
- None — Select this option if no border line is to be drawn.
- Single hairline — Select this option to draw a single hairline for the border.
- Single thin line — Select this option to draw a single thin line for the border.
- Double hairline — Select this option to draw a double hairline for the border.
- Double thin line — Select this option to draw a double thin line for the border.

Across Left to Right Before Down — Pages arranged horizontally from left to 
right and then top to bottom on one sheet.

Across Right to Left Before Down — Pages arranged horizontally from right to 
left and then top to bottom on one sheet.

Down Before Across Left to Right — Pages arranged vertically from top to bot-
tom and then left to right on one sheet.

Down Before Across Right to Left — Pages arranged vertically from top to bot-
tom and then right to left on one sheet.
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— Duplex
In the Duplex menu, you can set Two-Sided printing (printing on both sides of a sheet).

1) Print on Both Sides
Select this check box to print on both sides of the paper. When this box is selected, select 
the binding direction at the [Binding] option.

2) Binding
This option sets the type of binding for Two-sided printed pages.
- Long-edge Binding — Select this option to bind along the long edge side of paper. The 

direction to be printed on the back side of the paper differs depending on the orientation.

- Short-edge Binding — Select this option to bind along the short edge side of paper. The 
direction to be printed on the back side of the paper differs depending on the orientation.

— Output Options
In the Output Options menu, you can save a print job as a file.

1) Save as File
Select this check box to save a print job as a file. When this box is selected, select the file 
type in the [Format] box.
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2) Format
This option sets the format to save a file.
- PDF — Select this option to save a print job as a PDF file.
- PostScript — Select this option to save a print job as a PS file.

— Error Handling
In the Error Handling menu, you can set how to report a PostScript error.

1) PostScript Errors
This option sets whether to print a PostScript error report.
- No special reporting — Select this option if you do not want to print PostScript error 

information.
- Print detailed report — Select this option to print PostScript error information.

2) Tray Switching
This option is not supported by this equipment.

— Paper Feed
In the Paper Feed menu, you can select the paper source or media type.

1) All pages from
Select this option when you want to use the same paper source for all pages. When this 
option is selected, select the paper source or paper type to be used in the box.
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2) First page from
Select this option when you want to specify different paper source for the first page and 
remaining pages. When this option is selected, select the paper source or paper type to be 
used for the first page in the box.

3) Remaining from
Select the paper source or paper type to be used for the remaining pages in the box. This 
option can be selected only when you select the [First page from] option.

— Printer Features
In the Printer Features menu, you can specify various image quality features.

Quality
In the Quality menu, you can specify various image quality features.

1) Halftone
This option sets how to print halftones.
- Auto — Select this option to print using proper halftone depending on the contents in the 

document automatically.
- Detail — Select this option to print halftone in detail.
- Smooth — Select this option to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the Toner Save mode.

When the Toner Save mode is enabled, printing may become light.
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Printing Modes
In the Printing Modes menu, you can set the way this equipment handles the print job. This 
menu allows you to enable various job types, such as Private Print, Proof Print and Hold Print.

1) Print Mode
This option sets the type of print job.
- Normal — Select this option to print a job normally (no other options).

2) Department Code
The Department Code feature can be used for managing each job. For example, a system 
administrator can check how many sheets of copies a certain department has made.
Select this check box if a department code is required for printing. When this option is 
enabled, specify the 5-digit department code in the DC menu.
Enabling the department code depends on whether this equipment is managed with depart-
ment codes or not. Ask your administrator for your department code.

 P.155 “Printing Modes DC”

3) Distinguish Thin Lines
Select this check box to print thin lines clearly.

4) Do not Print Blank Pages
Select this check box to ignore blank pages for printing.

When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the 
blank pages will be printed.
Pages with header or footer will be printed even if the content is blank.

1

2

3

4



Printing from Macintosh    155

Printing Modes DC
In the Printing Modes DC menu, you can specify your department code, if the Department Code 
option is enabled on the equipment. Before specifying the department code, you must check the 
Department Code option in the Printing Modes menu. Then specify the department code in this 
menu.

When the department management is enabled, if printing is performed with an incorrect depart-
ment code, a dialog box indicating that it is incorrect appears. In this case, enter the correct one 
or stop transmitting. If this dialog box does not appear, the job becomes invalid and is deleted. 
An error report is then printed out from this equipment.

1) Department Code (DC) - Digit 1
Select the first digit of the department code.

2) Department Code (DC) - Digit 2
Select the second digit of the department code.

3) Department Code (DC) - Digit 3
Select the third digit of the department code.

4) Department Code (DC) - Digit 4
Select the fourth digit of the department code.

5) Department Code (DC) - Digit 5
Select the fifth digit of the department code.
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— Summary
In the Summary menu, you can confirm the current settings for printing.
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Scan to TWAIN

You can retrieve the images stored in the memory of the equipment using the TWAIN-compliant 
application software if the TWAIN driver attached  to GA-1201 is installed in the equipment.

The Scan to TWAIN operational procedure is as follows. The installation of a TWAIN driver is 
required only once at the first stage. Perform steps 2 and 3 to retrieve images.
1. Install the TWAIN driver in the equipment.
2. Scan the image using the control panel of the equipment. (The scanned image file is stored 

in the memory of the equipment.)
3. Retrieve the image stored in the memory of the equipment to a client computer using the 

TWAIN-compliant application software.

In Macintosh computers and UNIX workstations, the image cannot be retrieved with the 
TWAIN driver.
Some TWAIN-compliant applications do not operate with TWAIN driver. In that case, see the 
manual or online help of the application.
A TWAIN-compliant application is not attached on Windows XP, Windows Server 2003, Win-
dows Vista, Windows Server 2008, and Windows 7. Purchase it individually for these sys-
tems.
Some applications do not support the TWAIN scanning of originals whose colors, sizes, or 
resolution levels are not unified. When you scan this type of originals into these applications, 
try to scan one page by one.
The image quality of the scanned image may differ depending on applications you are using. 
If you feel the image quality of the scanned image is not satisfactory, try other applications.
The result of Scan to TWAIN can be confirmed. 

Requirements for TWAIN driver
TWAIN driver can be operated under the following environments:

Display resolution: 1024 x 768 dots or more
Display color: 16 bits (high color) or more
CPU: Pentium 133 MHz (Pentium 266 MHz or higher is recommended)
OS:
Windows 2000 Service Pack 4
Windows XP Service Pack 1/ Service Pack 2/ Service Pack 3
Windows Server 2003 Service Pack 1 or later 
Windows Vista Service Pack 1/ Service Pack 2
Windows Server 2008 Service Pack 1 or later
Windows 7 Service Pack xx or later
Required software:
TWAIN-compliant application (when TWAIN driver is used)
Microsoft Internet Explorer 5.5 Service Pack 2 or later
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About TWAIN Driver

Please refer to “GA-1201 Scanning Guide“ about the following topics.
Installing TWAIN Driver
Uninstalling TWAIN Driver
Operating with Control Panel of This Equipment
Retrieving Images with TWAIN Driver
Using TWAIN Driver for the First Time
How to Use the Main Window
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